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About This Manual
This installation guide covers the steps involved to install and use the client 
component of Mylex’s Global Array Manager® with Mylex PCI Disk Array 
Controllers for Software Kit 5. 

For information on installing and running the server component of Global 
Array Manager, consult the Global Array Manager Server Software 
Installation Guide and User Manual for Software Kit 5.

Conventions

Throughout the manual, the following conventions are used to describe user 
interaction with the product:

bold The user must enter the bold text exactly as shown

↵ Press the Enter key, or

Enter Press the key labeled “Enter” (or “Delete”, etc.)

File->Run Select the Run option from the pull-down menu 
activated when the File menu pad is selected

☛ Note
Supplementary information that can have an effect on 
system performance.

� Caution
Notification that a proscribed action has the potential 
to adversely affect equipment operation, system 
performance, or data integrity.

� WARNING
Notification that a proscribed action will definitely 
result in equipment damage, data loss, or personal 
injury.
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Chapter 1
Introduction
Overview
Global Array Manager® (GAM) Client software manages the AcceleRAID 
and eXtremeRAID families of PCI RAID controllers. This manual provides 
information on GAM Client for Software Kit 5. Software Kit 5 supports new 
server features for the following controllers:

• eXtremeRAID 2000/3000 

• AcceleRAID 352/170/160 

If you are using Mylex controllers that are not listed above, refer to the 
Global Array Manager Client Installation and User Manual for Software Kit 
4.

GAM Client software is used to:

• Monitor and manage virtually unlimited numbers of server and disk 
array groups.

• Monitor, manage, maintain, and configure Mylex Disk Array 
Controllers and the physical and logical drives that are connected to 
these controllers, even across remote servers.

• Monitor and manage SCSI Host Bus Adapters and the physical devices 
that are connected to these adapters, even across remote servers.

.

Manual No. SA67-0049-01 1-1



Overview
Global Array Manager Components

Global Array Manager has two components:

• Global Array Manager Server component (which is part of the Mylex 
Disk Array Controller Software Kit 5)

• Global Array Manager Client component

Each component handles specific tasks based upon the selected function.

Configuration Functions

Configuration functions are easily performed using RAID AssistTM, an 
intuitive, wizard-like utility in the GAM Client component that simplifies 
the process of setting up or reconfiguring a disk array. Just answer a few 
brief questions, and RAID Assist automatically does the rest. Use Manual 
Configuration for more control over drive group setup or individual 
configuration parameters.

Monitoring Functions

The Global Array Manager Server component collects and disseminates 
information on disk array or HBA subsystem status and resource utilization. 
The Global Array Manager Client component organizes this information 
through an intuitive graphical display. Errors and events are recorded in a log 
file and in the Log Information Viewer window, and if a problem is serious 
enough to warrant immediate attention, operators can be alerted via popup 
windows, pagers, fax, or email if so desired.

Maintenance Functions

The Global Array Manager Client manages or performs maintenance on 
individual disk arrays and drives (with the appropriate authentication), again 
by means of the graphical user interface. This includes removing physical 
devices from operation in a functioning disk array (also known as “killing” 
or off-lining a drive), rebuilding drives, selecting hot spares, and initiating a 
consistency (or parity) check on arrays that are configured to support 
redundancy. The Global Array Manager Server executes the management 
instructions specified by the Global Array Manager Client.
1-2 GAM Client User’s Guide



Introduction
Requirements
Since Global Array Manager is a client/server application, the GAM Server 
software component provided in the Mylex Disk Array Controller Software 
Kit must be installed in one or more file servers in order for the GAM Client 
software component to operate. Hardware and software requirements for 
installation and operation of the GAM Server component are described for 
each supported network operating system in the Global Array Manager 
Server Software Installation Guide and User Manual.

Client Hardware and Software

• PC-compatible computer with an 80486 or higher class processor and 
at least 4 MB of system memory (Pentium® processor and 16 MB of 
system memory are recommended)

• Network interface card connected to a functioning network

• Appropriate network device drivers for the installed network interface 
card

• For proper client component connectivity, installed and functioning 
GAM Server software component on the server, under any of the 
supported operating systems

• CD-ROM drive for CD-ROM installation, or 3 1/2-inch disk drive for 
diskette installation

• Fixed disk with at least 8 MB available free space (16 MB 
recommended)

• Mouse or other pointing device

• A minimum display screen setting of 800 x 600 is recommended. 
However, we recommend setting the display at 1024 x 768 for 
optimum GAM client viewing.

• Component installation and operation: Linux, Microsoft® Windows® 
XP 32-bit and 64-bit, Windows 2000, Windows NT® 4.0, Windows 
95, Windows 98, or Microsoft Me™ installed on a local hard disk

• TCP/IP stack installed
Manual No. SA67-0049-01 1-3



Requirements
Optional

• Modem or Fax/Modem (Hayes-compatible)

• MAPI- or SMTP-compliant messaging such as Microsoft Outlook™ 
(Required for Windows)

• Microsoft Exchange®, and Microsoft At Work® (Windows 95) for fax 
notification of events

Refer to your server documentation and to the Windows documentation for 
more information on hardware and operating system requirements.
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Chapter 2
Installation
Installation Overview
Installation of the Global Array Manager Client component requires one of 
the following operating systems:

• Windows XP 32-bit or 64-bit

• Linux (using Wine)

• Windows NT 4.0

• Windows 2000

• Windows 98

• Windows Me

This chapter assumes that the network administrator for this site will be 
performing these installation procedures.

If you are installing GAM Client, you may also choose to install GAM 
Server and its subcomponents at the same time on the same system. When 
installing GAM Server, dialog boxes for the server component appear and 
require a computer restart before launching the GAM Client software. Refer 
to the Global Array Manager Server Software Installation Guide and User 
Manual for GAM Server installation instructions.
Manual No. SA67-0049-01 2-1



Installation of Global Array Manager Client
Installation of Global Array Manager Client 
Global Array Manager software is shipped on an accompanying distribution 
CD-ROM. The file list (and path) is as follows (where X: represents the 
drive letter of your CD-ROM drive):

X:\GAM\WINNT\ (X:\GAM\WIN2K\ or X:\GAM\WIN64\)

_INST32I.EX_ DATA.TAG SETUP.EXE
_ISDEL.EXE DATA1.CAB SETUP.INI
_SETUP.DLL DATA1.HDR SETUP.INS
_SYS1.CAB LANG.DAT SETUP.LID
_SYS1.HDR LAYOUT.BIN
_USER1.CAB OS.DAT
_USER1.HDR

Installing Global Array Manager Client Software

1. If you intend to install GAM Server with GAM Client, make sure 
TCP/IP is installed and functioning properly.

2. Insert the distribution CD-ROM into your CD-ROM drive.

AutoRun will cause the CD-ROM to display the Mylex RAID 
Management Software Installation menu (Figure 2-1).

Figure 2-1. Mylex RAID Management Software Installation Menu

3. Click the option called “Install Global Array Manager.” This option is 
used to install GAM Server and GAM Client.
2-2 GAM Client User’s Guide



Installation
Global Array Manager Setup will load the installation wizard.

4. After a few moments, the Welcome dialog box will display 
(Figure 2-2). Click Next to proceed with the installation, or click 
Cancel to end the installation procedure and return to the menu.

Figure 2-2. Welcome Dialog Box

5. When the IBM Software License Agreement screen displays, click Yes 
to accept the terms of the agreement and continue.

If you click No, you will not be allowed to continue GAM Client 
installation.

The Select Components dialog box is displayed as shown in Figure 2-3. At 
this point you will select the component(s) you wish to install.
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Installation of Global Array Manager Client
Figure 2-3. Select Components to Install

6. To select Global Array Manager Client for installation, click the box (if 
necessary) to check the Global Array Manager Client option.

☛ Note
If installing the Global Array Manager Client, you 
may also choose to install Global Array Manager 
Server at this time. Instructions for GAM Server 
installation are described in the Global Array 
Manager Server Software Installation Guide and 
User Manual. 

7. Click Next and follow the on-screen prompts.
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Installation
Installing Global Array Manager Client with Linux
Installing the Global Array Manager Client on a Linux operating system 
requires the use of Wine™. Wine is a program that ports the GAM Client 
onto Linux. It is highly recommended that you use the Wine version from 
the specified web site. This version of Wine has been tested with GAM 
Client and we do not guarantee that our product supports other versions.

Install Wine

Go to the following web site to download Wine:

http://www.rpmfind.net

Refer to the following web sites for further information on Wine.

http://www.winehq.com

http://www.codeweavers.com

Install GAM Client

Global Array Manager software is shipped on an accompanying distribution 
CD-ROM. The file path is as follows (where x: represents the current 
version number.):

\GAM\Linux\gam-client-x.xx-xx.i386.rpm

Install GAM Client on Linux:

rpm -ivh gam-5.00-xxxxxxxx.i386.rpm

GAM will be installed under /opt/gam

To run GAM Client see“Starting Global Array Manager” on page 3-1. 
Further information is available in README.TXT file in the distribution 
CD-ROM
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Installing Global Array Manager Client with Linux
To Uninstall GAM Client Software

1. Query the installed GAM Client software:

rpm -qa | grep gam

2. Uninstall GAM Client software:

rpm -e gam-5.00-xxxxxxxx
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Chapter 3
Startup & NavigationNavigation
Starting Global Array Manager
Starting the Global Array Manager Client requires both the Server and 
Client components. It is required that you install and start GAM Server 
before you attempt to run the Global Array Manager Client.

Server Component

Installation and startup of the Global Array Manager Server component is 
covered in the Global Array Manager Server Software Installation Guide 
and User Manual. The software for GAM Server is provided on the 
installation CD-ROM.

Refer to the appropriate sections in the above-mentioned manual for 
instructions on starting the Global Array Manager Server component under 
any of the supported network operating systems.

Client Component

Under Windows XP 32-bit and 64-bit, Windows Me, Windows 2000, 
Windows NT 4.0, Windows 98 or Linux, you are ready to start the Global 
Array Manager Client once you have installed the client on your workstation 
(see “Installation” on page 2-1). 

To start GAM Client:

• Under Windows XP 32-bit and 64-bit, Windows Me, Windows 2000, 
Windows NT 4.0, or Windows 98, start the GAM Client software by 
selecting 
Start->Programs->Mylex Global Array Manager Client. 

• Under Linux, type gam.

If at least one server group and file server are defined, the opening screen 
appears. If not, the Define Server Groups dialog box appears (see “Setting 
Up Server Groups and Servers” on page 3-17).

☛ Note
In order for event notification to occur, the Global 
Array Manager Server and Global Array Manager 
Client must be running at all times.
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Navigating Global Array Manager Client
Navigating Global Array Manager Client
This section describes the navigating features and options that GAM 
provides.

Button Controls

Dialog boxes throughout the Global Array Manager Client have a series of 
control buttons. Some examples of these include:

Click this button to apply the settings made in the dialog box.

Click this button to cancel the settings made in the dialog box.

Click this button to confirm the action identified in the dialog 
box.

Click this button to cancel the action identified in the dialog 
box.

Click this button to close the active dialog box.

Click this button to apply your configuration changes.
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Startup & Navigation
Components of the GAM Client Opening Screen

Upon startup (with defined servers), Global Array Manager Client displays 
the opening screen, consisting of the Global Array Manager window, the 
Global Status View window, and the Log Information Viewer (Figure 3-1).

Figure 3-1. Opening GAM Screen

Components of the GAM Client Windows

The major components of the GAM Client windows (Figure 3-1) are 
described below.

1. Item #1 is the menu bar. There are five menus with several selections 
each. The contents of the menus and the functionality of several of the 
most important selections will be described throughout this guide.

2. Item #2 is the toolbar. There are seven toolbar icons representing eight 
of the most useful functions available in GAM Client. The identity of 
each toolbar icon and an explanation of the purpose of each will be 
described in later sections of this chapter.

3. Item #3 is the server selection box. When selected, the box displays the 

#1 #2 #3 #4

#5
#6 #7
Manual No. SA67-0049-01 3-3



Navigating Global Array Manager Client
names of each server group that is in contact with the current client 
workstation. Each group may consist of multiple servers. You may 
select a specific server group to view, or select “All Servers” if you 
want to view all the servers that are connected to this workstation.

4. Item #4 is the controller selection box. When selected, the box displays 
the controller ID (C-0, C-1, etc.) and controller type (BT-952, 
eXtremeRAID 2000, etc.) of each SCSI HBA and PCI/SCSI connected 
to the currently-selected server. 

Components of the Global Status View Window

The major components of the Global Status View window (Figure 3-1) are 
described below:

5. Item #5 is an icon that represents the currently-selected file server 
running the GAM Server component. The icon identifies:

• the IP address (e.g. 10.17.3.172) or name (e.g. ide40) of the server
• the network operating system running on the server (e.g. 2000 = 

Windows 2000; NT = Windows NT; NW = Novell NetWare, etc.)
• the operational status of the server (green = functioning, yellow = 

attempting connection, red ‘X’ = unable to connect)
• the number of DAC (PCI/SCSI) controllers and/or SCSI HBA 

controllers connected on the server, with a controller operational 
status light (green = functioning, yellow = critical, red ‘X’ = down 
or nonfunctional)

6. Item #6 is an icon that represents a currently unselected file server 
running the GAM Server component. The icon identifies the same 
information described above.

Components of the Log Information Viewer

7. Item #7 in Figure 3-1 is the GAM Client Log Information Viewer. Each 
line in the Log Information Viewer identifies a single event (error, 
status, warning, etc.) which was noted during monitoring by a file 
server running GAM Server, and was transmitted by that server to this 
client workstation. Relevant details accompany the event:

• Event ID. Displays an icon showing whether the event is 
informational, cautionary, a warning, etc., plus the identification 
number assigned to this event.
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Startup & Navigation
• Severity. The severity level of this event.
• Source. The IP address or name of the file server that is the sender 

(source) of this event.
• Source Time. Day of the week, month, day of the month, time of 

day, and year at the source file server’s location when this event 
occurred.

• Device Address. Relevant channel/target or other data pertaining to 
the source of this event.

• Description. Text of the message describing what occurred.
• Sequence (Seq). Number representing where this event fell in a 

stream of events from the same source.
• Local Time. Day of the week, month, day of the month, time of day, 

and year at the local client workstation’s location when this event 
arrived.

Components of the Controller View Window

Open the Controller View window by double-clicking any server icon in the 
Global Status View, or as shown in Figure 3-2:

Figure 3-2. Select “Controller View”

The Controller View window (Figure 3-3), displays the following 
information about the controller currently selected in the controller selection 
box:

• Item #1: The number of channels on this controller, each channel 
depicted as a tower.
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Navigating Global Array Manager Client
• Item #2: The physical devices present on each channel, specifying 
the target ID, capacity of the device, device type, and device status. 
See “Physical Device and Logical Drive Monitoring” on page 5-6 
for more information.

• Item #3: The logical drives configured on the controller, specifying 
the logical drive number, capacity of the logical drive, configured 
RAID level, and logical drive status.

• Item #4: The enclosure device present on each channel, specifying 
the device inquiry data (vendor, bus width, etc...), and the device 
state.

• Item #5: The host device present on each channel, specifying the 
device inquiry data (vendor, bus width, etc...), and the device state.

Figure 3-3. Controller View Window – “Non-Fibre” RAID Controller

#1 #2 #3

#4 #5
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Startup & Navigation
eXtremeRAID 3000

The Controller View window for the eXtremeRAID 3000 (Figure 3-4), 
displays the same information as described in the previous section. However, 
it is organized graphically to allow many more targets to be shown in each of 
the fibre channels, and the Controller View is scrollable. 

The number of targets per column can be set in the GAM2CL.INI file.

Channel 0 represents the internal SCSI channel.

Figure 3-4. Controller View Window – eXtremeRAID 3000 Controller

Status Icons
The following icons display the status of logical and physical devices in the 
Controller View Window:

Physical Device Offline State

Physical Device Online State (configured)

Physical Device Rebuild State

Physical Device Unconfigured

Spare Physical Device

Logical Drive Critical State
Manual No. SA67-0049-01 3-7



Status Icons
Logical Drive Consistency Check State

Logical Drive Online State (configured)

Logical Drive Offline State
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Startup & Navigation
Menu Bar and Menus

GAM Client contains a menubar (Figure 3-5) in the Global Array Manager 
window.

Figure 3-5. Menu Bar

File Menu

The File menu (Figure 3-6) contains the following options:

• Open Configuration (Ctrl+O): Loads a configuration from disk and 
saves it to the controller. (See “Setting Up Server Groups and Servers” 
on page 3-17.)

• Save Configuration (Ctrl+S): Saves a configuration file to a new 
filename, disk, and/or directory.

• Clear Configuration: Removes configuration information from the 
selected array on the selected controller.

� Caution
Although there are confirmation checkpoints and 
warnings following selection of this option, remember 
that all existing configuration and file data (on all 
drives connected to the array) will be deleted.

• Exit: Exits the GAM Client.

Figure 3-6. File Menu
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Status Icons
View Menu

The View menu (Figure 3-7) contains the following options:

• Global Status View: Toggles the Global Status View window. The 
Global Status View window opens by default when Global Array 
Manager Client starts.

• Controller View: Toggles the Controller View window showing 
channel/ID/target information and physical device/logical drive 
configurations for the controller selected in the controller selection 
box.

• Log Information Viewer: Toggles the Log Information Viewer, a 
window showing a log of recent system error and status event 
messages. The Log Information Viewer opens by default when Global 
Array Manager Client starts.

• Foreground Initialization Status: Displays the progress (percent 
complete) of an ongoing full foreground initialization of one or more 
drives.

Figure 3-7. View Menu

• Background Initialization Status: Displays the progress (percent 
complete) of an ongoing full background initialization of one or more 
drives.

• Rebuild Status: Displays the progress (percent complete) of an 
ongoing device rebuild.
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• Consistency Check Status: Displays the progress (percent complete) 
of an ongoing logical drive consistency check.

• Expand Capacity Status: Displays the progress (percent complete) of 
an ongoing data restriping process across the target RAID group.

• Patrol Read Status: Enables GAM Client to poll every 1 minute to get 
new status data from the controller.

• Error Table: Displays a table of bad block and “request sense” data 
generated as a result of finding areas of damage or data unavailability 
on a storage device. Data for all storage devices on the selected 
controller are presented in the same tables.

• Cluster Map: Displays a graphical back end cable connection for the 
controller selected from the cluster controller list.

Administration Menu

The Administration menu (Figure 3-8) contains the following options:

• Sign On: Enables use of GAM’s configuration and administration 
functions to “Administrators” (“gamroot” + password). Enables only 
monitoring functions to “Users.”

• Define Server Groups: Sets up server groups and individual server 
names or IP addresses within each group.

• Select Current Server Group (Ctrl+G): Displays the current contents 
of the server selection box located in the Global Array Manager 
window. Functions in the same way as directly selecting the server 
selection box.

• Select Current Controller (Ctrl+C): Displays the current contents of 
the controller selection box located in the Global Array Manager 
window. Functions in the same way as directly selecting the controller 
selection box.

• RAID Assist: Mylex’s built-in RAID Controller configuration utility. 
Facilitates configuration tasks using either one-step “automatic” 
configuration, a configuration “wizard” assistant, or a manual 
(advanced level) configuration option allowing more control over 
configuration parameters.
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Figure 3-8. Administration Menu

• Initialize Logical Drives: Offers the ability to run a full initialization 
of logical drives at a time of your choice, not just immediately 
following a new configuration. If it’s inconvenient to follow a 
configuration immediately with a logical drive initialization, you can 
decline the initialization and use this menu item to start the process at a 
later time.

� Caution
If you perform an initialization on a logical drive(s) 
that you are currently using for data storage, you will 
lose the data stored on the drive(s).

• Controller Information: Displays key information about the 
currently-selected controller.

• Enclosure Information: Displays information and status about 
components in the external disk enclosure.

• Controller Options: Sets various parameters for the selected Disk 
Array Controller or SCSI HBA. Unlike Controller Information, user 
definable controller parameters are modified in Controller Options.

• Physical Device Options: Displays a list of all physical devices 
connected on the currently-selected controller and allows the user to 
change transfer speed, transfer width, and/or tag value for individual 
devices.
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• Intelligent BBU: (Only enabled if the selected controller has an 
Intelligent Battery Backup Unit installed.) Displays a dialog box from 
which you can do the following:

• Monitor the power remaining in the Intelligent BBU.
• Request reconditioning of the Intelligent BBU (for eXtremeRAID 

2000 and eXtremeRAID 3000).
• Set the low power threshold.
The Intelligent BBU’s features and functionality are described in detail 
elsewhere. GAM simply offers a way of keeping up-to-date as to the 
condition and charge in the battery.

• Scan Devices: Scans for new devices that have recently been added 
and which are not currently identified within GAM Client.

• Advanced Functions: Opens a submenu (Figure 3-9) from which you 
can select the following options:

• Flash Utility: Provides the ability to upgrade controller firmware, 
BIOS, boot block, or BIOS configuration utility as new maintenance 
releases become available.

• PATHpilot: Starts the PATHpilot Information Control Console 
(PIC) as a separate application. See “Clustering & Teaming” on page 
4-38 for more information.

Figure 3-9. Advanced Functions Submenu

• Settings: Opens a tabbed dialog box in which you can specify the 
Alert/Alarm, Communication, and Event Editor settings that you 
desire. Examples of such settings include type of alarm, such as pager, 
fax, email, etc., modem baud rate, COM port, stop bits, data bits, parity, 
event severity level, event message editing, and so on.
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Window Menu 

The Window menu (Figure 3-10) is a standard feature of Windows XP 32-bit 
and 64-bit, Windows Me, Windows 95/98, Windows 2000, and Windows 
NT. It is implemented as such in GAM.

Figure 3-10. Window Menu

Help Menu

The Help menu (Figure 3-11) identifies the on-line help options available 
within the Global Array Manager Client.

• Contents (F1): Displays a list of available help topics.

• About Global Array Manager: Displays the Windows standard 
“About” box.

Figure 3-11. Help Menu

Toolbar and Toolbar Icons

GAM Client contains a toolbar (Figure 3-12) in the Global Array Manager 
window.

Figure 3-12. Toolbar

Each toolbar button corresponds to a function available from the menu bar.

Disk Configuration WizardWizard: Brings up the RAID 
Assist dialog box for RAID controller configuration.
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Scan Devices: Scans for new, recently added devices 
which are not yet identified within GAM.

Displays Controller Information: Displays key 
information about the currently-selected RAID 
Controller or HBA.

Error Table: Displays a table of “request sense” 
data.

Sign-On: Enables configuration and 
administration functions to Administrators and 
monitoring functions to “Users.”

Settings for Events: Opens a dialog box for 
specifying the Alert/Alarm, Communication, and 
Event Editor settings that you desire.

Help Contents: Displays the on-line help 
contents page.
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Exiting Global Array Manager
Exit Global Array Manager Client as shown in Figure 3-13:

Figure 3-13. Select “Exit”

☛ Note
We recommend leaving the GAM Client running as 
long as there are servers you wish to monitor or 
configure. If you do exit, you will be unable to receive 
events from GAM Server and you will not be 
informed of errors or status unless you restart GAM 
Client and reconnect to the server(s).

Exiting GAM Server

Refer to the GAM Server manual for Software Kit 5 for details on how to 
exit GAM Server.
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Setting Up Server Groups and Serversp Server Groups and Servers

Adding a Server Group to the Server Group List

Open Define Server Groups as shown in Figure 3-14. (This is not necessary 
if you are starting GAM and no Server Groups are defined. The Define 
Server Groups dialog box will display automatically.)

Figure 3-14. Select “Define Server Groups”

In the Define Server Groups dialog box (Figure 3-15), do the following:

1. Click the Add button under the Server Groups section of the dialog 
box.

Figure 3-15. Define Server Groups Dialog Box
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2. In the Adding Item dialog box, type the name of the server group that 
you are adding.

3. Click OK. The Define Server Groups dialog box will reappear with the 
newly-defined server group added.

☛ Note
The Discovered group contains a list of all server 
hosts that are sending events to the client.

Adding a Server to the Server Groups List

With the Define Server Groups dialog box open (Figure 3-15), do the 
following:

1. Click the Add button under the Servers section of the dialog box.

2. In the Adding Item dialog box, type the IP address of the server that 
you are adding. If you’re running GAM Client under Windows XP 
32-bit and 64-bit, Windows 2000, Windows NT or Linux, you may 
instead type the name of the server.

3. Click OK. The Define Server Groups dialog box will reappear with the 
newly-defined server added.

4. To add more servers to the group, repeat steps 1 through 3.

5. Click OK in the Define Server Groups dialog box when you are 
finished.

After adding servers, Global Array Manager returns to the Global Status 
window.

☛ Note
Select “All Servers” to see all servers in the Global 
Status view.
3-18 GAM Client User’s Guide



Startup & Navigation
Signing On to a Server
This section describes the different server access levels and the methods of 
signing onto the Global Array Manager Client.

Security Access Levels

The ability to perform certain actions within the GAM Client depends on 
your security access level. There are three levels of security access, Guest 
(no sign-on), User, and Administrator.

☛ Note
Do not confuse GAM’s Administrator access level 
with the Windows’ log on name “Administrator,” they 
are not the same. The password “gamroot” is required 
to be established as a user on the server host. It is 
recommended that the “gamroot” user be established 
with Windows’ “Administrator” privileges or Linux’s 
root privileges. The “gamroot” account must be 
password protected and the password must be 
managed in a security conscious manner. GAM relies 
on the server host’s operating system security 
measures. Therefore, proper handling of the 
“gamroot” password is critical to the protection of 
user data on the controller.

Guest

Guest access level is achieved by not signing on to a server host. Guests can 
monitor the Log Information Viewer and the Global Status View. Guests 
cannot view or make changes to any controller parameters or configurations.

User

User access level is achieved by signing on to a server host using a username 
that is not “gamroot,” but one that the administrator of that server assigns. 
Users have all the capabilities of Guests. Users can also view the detailed 
status of a controller by activating the Controller View, Controller 
Information and Enclosure Information. Users cannot view or make changes 
to any controller parameters or configurations.
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Administrator

Administrator access level is achieved by signing on to a server host using 
the username “gamroot”; use of a password is highly recommended. 
Administrators have the capabilities of Guests and Users plus the full 
privilege to view and change the status and settings of the selected controller 
and other internal GAM settings.

Signing On

To gain access to capabilities beyond Guest access level, you must sign on to 
a server host. 

Double-click a host icon in the Global Status View (Controller View must be 
closed first). 

• The Sign On dialog opens if you have never signed on during this 
session or if you did not check the Sign On dialog’s Remember 
password box on the previous sign on (see Figure 3-16). 

• If you have previously signed on and did check the Remember 
password box then the previously entered username and password will 
automatically be used for this new sign on. 

Figure 3-16. Sign On Dialog Box

If the sign on fails, the Sign On dialog will open to allow adjustment of the 
username and/or password or you may open Sign On at any time as shown in 
Figure 3-17.
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Figure 3-17. Select “Sign On”

GAM’s internal operation during Sign On is to: 

1. Encrypt the username and password and send them to the GAM Server 
running on the selected server host. 

2. The GAM Server receives and decrypts the username and password 
and makes an operating system specific call to validate them per the 
server host’s operating system’s user accounts.

3. After the username and password are validated by the operating system 
the username is compared to the string “gamroot”. If the username 
matches, sign on is granted Administrator access level.

4. The GAM Server notifies GAM Client of the success or failure of the 
sign on attempt and whether or not that sign on attempt has been 
granted Administrator access level.

Do the following to sign on to a server:

1. Type a username and password of your choice that are previously 
enabled on the server host. 

This will provide access privileges appropriate for the username.

2. Check the box labeled “Remember password for this session” if you 
want GAM to refrain from Sign On messages each time you select a 
server during this session which uses the same password. This amounts 
to an automatic sign-on to additional servers and should be used with 
caution.
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Uncheck the box if you want to retain the option of signing on to each 
server you wish to access individually.

3. Click the Sign-On button (see Figure 3-16).

Setting and Modifying User Preferences
Open Settings by clicking Administration->Settings on the menu bar or the 
Preferences icon as shown in Figure 3-18.

Figure 3-18. Select “Settings”
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Alert Preferences

Figure 3-19. Settings Dialog Box – Alert Preferences

In the Settings dialog box, under the Alert Preferences tab (Figure 3-19), you 
have several options:

Event Log

• Append events to your current log file, or

• Replace the log file (overwrite it)

• Rename the log file

• Enable or disable the event logging function

Enable Global Alerts for Severity Level(s)

• For each type of alarm (Email, Pager, Fax, Launch Application, and 
Alarm Sound) check the box(es) corresponding to the event severity 
level(s) for which you would like to enable this type of alarm globally.

For example, in Figure 3-19, all Level 0 and Level 1 messages/events 
will result in an alarm sound locally, and email, page (Level 0 only), 
and fax to those individuals identified in Alarm Setup.
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Events are numbered from 0 for most severe to 4 for least severe, and 
can be edited by the user.

Finish by doing one of the following:

• Click OK to accept the global alert settings and exit the Settings dialog 
box, or 

• Click Cancel to leave original settings unchanged, or 

• Click another Settings tab to set additional user preferences.

Alarm Setup

The top half of the Alarm Setup dialog box lists the types of alarms that can 
be used (Pager, Fax, Email, Launch Application). The lower half of the 
Alarm Setup dialog box lists the currently defined destinations/recipients/
applications for the alarm type selected in the upper window (Figure 3-20).

☛ Note
Email requires MAPI- or SMTP-compliant messaging 
(e.g. Microsoft Outlook), as well as Microsoft 
Exchange.

Figure 3-20. Settings Dialog Box – Alarm Setup
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Add a Pager

1. Select the Pager alarm type in the upper window.

2. Click Add.

The Pager setup box is displayed as shown in Figure 3-21.

Figure 3-21. Pager Setup Dialog Box

3. In the Pager box:

• Enable or disable this Pager entry using the Enabled check box.
• Type the Modem Setup String, or keep the default.
• Type a Pager Prefix, or keep the default.
• Type the phone number of someone who will receive a page.
• Type a Pager Suffix if needed.
• Type a Pager Delay interval. The value of each comma is 1 second.
• Type the Modem Hang-up String, or keep the default.

☛ Note
Please consult your modem manufacturer or modem 
documentation for the specific strings which work 
best with your modem.
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• Select the appropriate button for a Numeric or Alphanumeric pager.

4. If you need to enter a Message Prefix, Suffix, or Delay interval, click 
Advanced. Type the desired information and click OK to return to the 
Pager setup box.

5. To test the pager using the settings you’ve input, click Test.

6. When you are satisfied with the Pager you’ve set up, click OK.

Your new Pager entry appears in the lower window of the Alarm Setup 
dialog box. (Refer to Figure 3-20 for an example.)

Remove a Pager

1. Select the Pager alarm type in the upper window of Alarm Setup.

2. Select the Pager entry to remove in the lower window of Alarm Setup.

3. Click Remove.

A confirmation message is displayed as shown in Figure 3-22.

Figure 3-22. Remove Pager Entry Message

4. Click Yes to remove the Pager entry, or click No to keep the entry.
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Add a Fax Using Windows

For fax notification Microsoft Exchange and Microsoft At Work Fax 
software must be installed on your system. GAM supports only Microsoft At 
Work Fax under Windows 95. The Software field is not selectable.

The required fax software components should already be available as part of 
the normal Windows installation.

To add a fax, follow these steps.

1. Select the Fax alarm type in the upper window of the Alarm Setup 
dialog box (Figure 3-23).

Figure 3-23. Fax Alarm Setup

2. Click Add.
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The Fax setup box is displayed as shown in Figure 3-24.

Figure 3-24. Fax Setup Dialog Box

3. In the Fax box:

• Enable or disable this Fax entry using the Enabled check box.

• Type the fax phone number of someone who will receive a fax.

• Type a fax header, if desired.

4. To test the fax using the settings you have input, click Test.

5. When you are satisfied with the Fax you have set up, click OK.

Your new Fax entry appears in the lower window of the Alarm Setup 
dialog box. (Refer to Figure 3-23 for an example.)

Remove a Fax

1. Select the Fax alarm type in the upper window of Alarm Setup.

2. Select the Fax entry to remove in the lower window of Alarm Setup.

3. Click Remove.

4. At the confirmation message, click Yes to remove the Fax entry, or 
click No to keep the entry.
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Add a Fax Using Linux

When using Linux, the behavior of the Fax Alert function is defined in 
gam2cl.ini file as follows, which is located under “~User/.gam/”.

☛ Note
If you are using a fax utility program other than “fax,” 
you may need to modify the FAXUSERSCRIPT 
accordingly.

[COMM_SECTION]

...

FAXUSERSCRIPT=/usr/bin/fax DEV=ttyS0 NAME=%H send %N %M

...

where,

%H is replaced with header string

%N is replaced with phone number to dial

%M is replaced with message file name
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Add an Email Using Windows

1. Select the Email alarm type in the upper window of the Alarm Setup 
dialog box (Figure 3-25).

Figure 3-25. Email Alarm Setup

2. Click Add.

The Email setup box is displayed as shown in Figure 3-26.

Figure 3-26. Email Setup Dialog Box

3. In the Email box:

• Enable or disable this Email entry using the Enabled check box.
• Type the email address of someone who will receive an email.
• Type the subject of the email.
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4. To test the email using the settings you’ve input, click Test.

5. When you are satisfied with the Email you’ve set up, click OK.

Your new Email entry appears in the lower window of the Alarm Setup 
dialog box. (Refer to Figure 3-25 for an example.)

Remove Email

1. Select the Email alarm type in the upper window of Alarm Setup.

2. Select the Email entry to remove in the lower window of Alarm Setup.

3. Click Remove.

4. At the confirmation message, click Yes to remove the Email entry, or 
click No to keep the entry.
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Add an Email Using Linux

When using Linux, the behavior of the E-mail Alert function is defined in 
gam2cl.ini file as follows, which is located under “~User/.gam/”.

[COMM_SECTION]
...
EMAILUSERSCRIPT=/usr/bin/mail -s “%S” %R < %M
...
where,

%S is replaced with subject string
%R is replaced with recipients
%M is replaced with message file name

Add an Application to Launch

1. Select the Launch Application alarm type in the upper window of the 
Alarm Setup dialog box (Figure 3-27).

Figure 3-27. Launch Application Alarm Setup

2. Click Add.

The Launch Application setup box is displayed as shown in 
Figure 3-28.
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Figure 3-28. Launch Application Setup Dialog Box

3. In the Launch Application box:

• Enable or disable this Application entry using the Enabled check 
box.

• Enable Launch Only Once if you want to prevent the application 
from launching again if GAM detects that it is already running.

• Type the name of an application to launch should certain events or 
messages require it. If you are using Linux, you need to type the full 
location path beginning with a slash (/).

• If you don’t remember the name or path of the application, click the 
Browse button.

4. To test the application launch using the settings you’ve input, click 
Test.

5. When you are satisfied with the application you’ve set up, click OK.

Your new application entry appears in the lower window of the Alarm 
Setup dialog box (refer back to Figure 3-27 for an example.)

Remove an Application to Launch

1. Select the Launch Application alarm type in the upper window of 
Alarm Setup.

2. Select the Launch Application entry to remove in the lower window of 
Alarm Setup.

3. Click Remove.
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4. At the confirmation message, click Yes to remove the application entry, 
or click No to keep the entry.

Properties

For any of the four alarm types (Pager, Fax, Email, Application), you may 
view a particular entry’s settings by selecting an entry in the lower window 
of Alarm Setup and clicking Properties.

Communication

In the Settings dialog box, under the Communication tab (Figure 3-29), you 
have the option to change any of the following:

Figure 3-29. Settings Dialog Box – Communication

Baud Rate

Select the baud rate appropriate to your communication hardware.

Port

Select the COM port at which your communication hardware resides.

Parity

Select the type of parity for communication sessions: None, Even, Odd, 
Mark, Space.
3-34 GAM Client User’s Guide



Startup & Navigation
Stop Bits

Select the number of stop bits required for communication sessions: 1, 1.5, 
2.

Data Bits

Select the number of data bits required for communication sessions: 4, 5, 6, 
7, 8.

Finish by doing one of the following:

• Click OK to accept the communication settings and exit the Settings 
dialog box, or 

• Click Cancel to leave original settings unchanged, or 

• Click another Settings tab to set additional user preferences.

Event Editor

Figure 3-30. Settings Dialog Box – Event Editor

In the Settings dialog box, under the Event Editor tab (Figure 3-30), you 
have several options.
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Event ID/User Event ID/Severity/Default

1. Select an Event ID to edit from the Event ID list box.
2. Type your own number for this event in the User Event ID list box, or 

keep the default (equal to the Event ID number).
3. Type your own event severity level in the Severity list box, or keep the 

default (set by IBM).
4. Click the Default button to return all settings for this particular event to 

their defaults.

Alarm for the Event

When all Global boxes are checked, you can view the alarms that will 
activate when this particular event occurs (these are based on the settings in 
Alert Preferences). Check or uncheck specific boxes if you wish to override 
these defaults and change the alarms for this event.

Event Message Text

Type new text for this event, or keep the default text (set by IBM).

After modifying the event definitions, a data file called “gam2cl.gef” will 
automatically be generated. This file will then be read at each GAM startup 
and a dialog box will be displayed (Figure 3-31).

Figure 3-31. gam2cl.gef dialog box

The dialog box message indicates that the file defines all events even for 
new releases of GAM that may have added new events. However, the new 
events will not be seen until the gam2cl.gef file is deleted and GAM client is 
restarted.

Default All

Click the Default All button to reset all events of all severity levels back to 
their defaults.
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Finish by doing one of the following:

• Click OK to accept the event settings and exit the Settings dialog box, 
or 

• Click Cancel to leave original settings unchanged, or 

• Click another Settings tab to set additional user preferences.

For More Information...
This concludes the Startup & Navigation chapter. For additional information 
on Global Array Manager options and functionality, refer to other chapters in 
this installation guide, and to the context-sensitive online help file available 
from the Help menu, by pressing F1, or by right-mouse-clicking an item on 
which you require help.
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Chapter 4
Configuration
Introduction
Configuration activities involve the following:

• Setting or modifying controller options to suit your application needs

• Modifying physical device options for data transfer or tag value

• Creating, modifying, or deleting Mylex RAID Controller 
configurations

• Loading a configuration from disk and saving it to the controller
Manual No. SA67-0049-01 4-1



Setting and Modifying Controller Options
Setting and Modifying Controller Options
Open Controller Options as shown in Figure 4-1.

Figure 4-1. Select “Controller Options”

To configure options for a controller, complete the following property pages.

Controller Options

To configure Controller Options, follow these steps:

1. Select the Controller Options tab (Figure 4-2). 
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Figure 4-2. Controller Options Dialog Box for new PCI DAC

2. Enable or disable (by checking or unchecking) any of the following 
global parameters:

• Automatic Rebuild Management. Works in conjunction with 
SAF-TE disk array enclosures to detect removal of a failed drive and 
perform an automatic rebuild after installation of a replacement 
drive. Change the default Rate Controls to less than or equal to 50. 
Do this by using the slide bar or typing the rate in the edit box. A 
rate of 50 dedicates the maximum allowable resources to a rebuild 
allowing it to proceed at its fastest.

• Background Initialization. Allows logical drive initialization to 
take place “behind the scenes” so that the logical drive is 
immediately available for use. If you disable this option, logical 
drives will need to complete their initialization process before they 
can be used. Change the default Rate Controls to less than or equal 
to 50. Do this by using the slide bar or typing the rate in the edit box. 
A rate of 50 dedicates the maximum allowable resources to an 
initialization allowing it to proceed at its fastest.
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• Consistency Check Rate. Change the default Rate Controls to less 
than or equal to 50. Do this by using the slide bar or typing the rate 
in the edit box. A rate of 50 dedicates the maximum allowable 
resources to a Consistency Check allowing it to proceed at its 
fastest. Lowering the number devotes more resources to I/Os and 
consequently slows the Consistency Check process.

• MORE Rate. Change the default Rate Controls to less than or equal 
to 50. Do this by using the slide bar or typing the rate in the edit box. 
A rate of 50 dedicates the maximum allowable resources to an array 
expansion or other MORE operation allowing it to proceed at its 
fastest. Lowering the number devotes more resources to I/Os and 
consequently slows any MORE process.

• Auto Drive Sizing. Allows the software to set similar drive sizes 
(e.g. 4.0 GB, 4.1 GB, 4.2 GB) to a common size automatically 
without the need to edit the mylexdrv.siz file. This leads to smoother 
operation by allowing drives of similar sizes to be treated as 
identical sizes for hot spares, replacement drives, and within arrays. 
If you disable this option, the software will read and use the current 
contents of mylexdrv.siz.

Change some of the following Startup Parameters:

• Disk Spin-up. On Command drive spin-up only. 

• Devices Between Spins. Number of devices to spin up at one time. 
A low number lessens the likelihood of a power drain.

• Initial Delay. Number of seconds between physical device start-ups.

• Delay Between Spins. Number of seconds between consecutive 
device spin-up cycles.

Clustering. Under Windows XP 32-bit and 64-bit, Windows 2000 or 
Windows NT 4.0, allows redundancy among controllers in various servers. 
If a controller or server fails, another controller can take over the disk drives 
and disk arrays that were formerly handled by the failed controller. This 
mechanism imparts a “fault tolerance” among controllers and servers.

Change the following Clustering Parameter:

Controller Host ID. Change if you want to set this controller’s target ID to 
something other than 7.
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Cache Line Size. The cache line size represents the size of the data in 
controller memory that will be read or written at one time.

Change the following cache line size parameters:

• User Selected. Select the 64KB cache line size if all of your logical 
drives have a stripe size greater than 64KB. If not, select the 8KB 
cache line size. If you try and select a 64KB cache line size and GAM 
detects one or more logical drives with a stripe size less than 64KB, a 
message box will open with the message “64KB Cache Line Size will 
be used only when all logical drives use 64KB or greater Stripe Size.”

• Active. Displays the cache line size that the controller is currently 
using. Read-Only field.

Click the OK button to accept the changes, or the Cancel button to discard 
them.

Advanced Controller Options

To configure Advanced Controller Options, follow these steps:

1. Select the Advanced Controller Options tab (Figure 4-3). 
 

Figure 4-3. Advanced Controller Options Dialog Box for new PCI DAC

Enable or disable (by checking or unchecking) the following parameters:
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• Temporarily Offline RAID Array. Prevents a second physical 
drive associated with a currently critical system drive from being 
permanently marked offline. The disk drive is marked temporarily 
unavailable or dead.

• Device Health Monitoring (S.M.A.R.T). S.M.A.R.T. (Self-
Monitoring Analysis and Reporting Technology) will monitor the 
condition of drives and global and dedicated hot spare drives that are 
part of a RAID configuration group. 

You can set the Polling Interval from 0–255 minutes, where 0 means 
that S.M.A.R.T. mode 6 is disabled.

• Patrol Read. Starts the Patrol Read operation automatically on 
power up. Patrol Read will periodically verify all sectors, including 
system reserved area in the RAID configured drives. It works for all 
RAID levels and standby drives. The patrol read is initiated only 
when the controller is idle for a defined period and has no other 
background activities. 

Once enabled, Patrol Read assumes that all configured system drives 
will undergo patrol read sequentially. When all configured drives are 
“patrolled,” it will repeat the operation over and over again.

You can set the Patrol Read Iterations from four hours to 1016 hours 
in multiples of four hours. 

• Fibre Channel Speed. Manages three speeds of the fibre channel.
Auto - Sets an Auto Negotiate speed for the host port(s) selected.
1 Gb - Sets a 1 Gigabits/second speed for the host port(s) selected.
2 Gb - Sets a 2 Gigabits/second speed for the host port(s) selected.

Click the OK button to accept the changes, or the Cancel button to discard 
them.

SCSI Host Bus Adapters

In the Controller Options dialog box (Figure 4-4), you have several options.
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Figure 4-4. Controller Options Dialog Box for SCSI HBA

Enable or disable (by checking or unchecking) the following SCSI Device 
Parameters:

• Wide Negotiation. Allows the controller to negotiate at wide data 
transfer rates.

• Disconnect. Allows the target to disconnect from the initiator.

Change the SCSI ID of this HBA.

Change either of the following Startup Parameters:

• Spin-up. No Spin up or Controller spin up.

• Delay. Number of seconds before physical device startup.

Change the following SCSI Device Parameter:

• Maximum data transfer rate of the disk side channels. Speeds are 
Asynchronous, 5 MHz, 10 MHz, and 20 MHz.

Click the OK button to accept the changes or the Cancel button to discard 
them.
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Modifying Physical Device Options
Open Physical Device Options as shown in Figure 4-5:

Figure 4-5. Select “Physical Device Options”

The Physical Device Options dialog box (Figure 4-6) displays and allows 
you to change certain physical device transfer options. 

Figure 4-6. Physical Device options Dialog Box

A list of physical devices connected to the currently-selected controller is 
displayed with the following information about each device:
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• Model number of the physical device (often includes drive size)
• Channel number and Target ID where this device resides on the 

controller
• The current Transfer Speed (in MHz) for the device
• The Transfer Width (8 bits or 16 bits) for the device
• The Tag Value

You may change the Transfer Speed, Transfer Width, and/or Tag Value for a 
single or for multiple physical device(s) as follows:

1. Select the physical device(s) in the window by clicking under Model.
Current settings are displayed under Setting Options.

2. Change the Transfer Speed and/or Transfer Width, if desired, by 
selecting an available option in the drop down list box.

3. Change the Tag Value, if desired, by typing a new value in the Tag 
Value field.

If you selected multiple devices together, all selected devices will be 
changed to the values you’ve specified.

Running RAID Assist
RAID Assist is the Global Array Manager Client’s “wizard” for the setup 
and configuration of new logical drives and disk arrays. 

In its simplest form, RAID Assist provides an Auto Configuration option 
which immediately configures all available drives into an optimal, RAID 5 
configuration. RAID Assist’s Assisted Configuration sets up a new array 
according to predefined parameters, and asks the user questions to gather the 
key information necessary to build the array.

If configuration needs go beyond what Auto or Assisted Configuration 
offers, the Manual Configuration option allows additional control over 
logical drive setup parameters.

Entering RAID Assist

Open RAID Assist by clicking Administration->RAID Assist on the menu 
bar or the RAID Assist icon as shown in Figure 4-7.
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Figure 4-7. Select “RAID Assist”

The RAID Assist “Welcome” dialog box displays (Figure 4-8).

Figure 4-8. RAID Assist “Welcome” Dialog Box

In the RAID Assist “Welcome” dialog box (Figure 4-8), do one of the 
following:

• Click the Automatic Configuration button if you want to provide only 
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minimal input and allow RAID Assist to set up an optimal 
configuration automatically, or

• Click the Assisted Configuration button if you want RAID Assist to 
lead you step-by-step through the configuration, or

• Click the Manual Configuration button if you want full control over 
your configuration setup, or

• Click Cancel if you want to exit RAID Assist without any changes.

Automatic Configuration

Automatic Configuration provides three options:

• New Configuration. Sets up a new configuration on the controller, 
deleting the previous configuration and data (if any).

• Add Logical Drive. Sets up additional arrays (logical drives) leaving 
the existing array(s) intact. At least one array must be configured on 
this controller, and unconfigured drive space must remain.

• Expand Array. Restripes data in your array across additional, 
unconfigured drives to expand the capacity of the array.

For example, open New Configuration as shown in Figure 4-9.

Figure 4-9. Select “New Configuration”
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The new configuration created is based on the total number of drives 
discovered by the Global Array Manager. The automatic configuration 
feature uses the maximum number of drives, provides a fault tolerant RAID 
level when able, and creates a hot spare drive for drive failure protection. 
The number of logical drives created is dependent on the total number of 
physical drives discovered.

The Finish screen displays (Figure 4-10). 

Figure 4-10. Automatic Configuration->New Configuration->Finish
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Do the following:

1. Examine the Configuration Summary for details about the 
configuration that RAID Assist will set up.

2. If you want to start over, click the Back or Cancel button, or the 
Welcome tab, OR

If you want to view the configuration before it is applied to the 
controller, click the Details button. You will be taken to an equivalent 
of the Disk Arrays page as shown in Manual Configuration, except that 
you can only view and close the details window. 

3. If you accept the configuration as presented, click the Apply button at 
the Finish page to apply the new configuration to the controller.

A warning confirmation box appears as shown in Figure 4-11.

Figure 4-11. WARNING Before Applying the Configuration

4. Type YES and click OK if you are sure you want to apply the new 
configuration and overwrite the old. If you’re not sure, click Cancel.
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Assisted Configuration

Assisted Configuration provides three options:

• New Configuration. Sets up a new configuration on the controller, 
deleting the previous configuration and data (if any).

• Add Logical Drive. Sets up additional arrays (logical drives) leaving 
the existing array(s) intact. At least one array must be configured on 
this controller, and unconfigured drive space must remain.

• Expand Array. Restripes data in your array across additional, 
unconfigured drives to expand the capacity of the array.

For example, open New Configuration as shown in Figure 4-12:

Figure 4-12. Select “New Configuration”

Assisted Configuration walks you step by step through a new configuration 
(Figure 4-13). Each “tab” in the Assisted Configuration dialog box collects 
information about an important aspect of the configuration you wish to set 
up. During this process, you provide answers to several questions.
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Fault Tolerance Tab 

Configure the following options (Figure 4-13) for fault tolerance.

1. Do you want Fault Tolerance? [Yes/No]

2. Do you want a Hot Spare? [Yes/No]

Figure 4-13. Assisted Configuration – Fault Tolerance
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RAID Level Tab If Fault Tolerance Was Yes (Figure 4-14), choose between:

• Parity error correction (RAID 5, RAID 3), or

• Fully redundant drives (RAID 1, RAID 0+1)

Figure 4-14. Assisted Configuration – RAID Level With Fault Tolerance
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RAID Level Tab If Fault Tolerance Was No (Figure 4-15), choose between:

• Striping (RAID 0), or

• Stand-alone drive (JBOD)

Figure 4-15. Assisted Configuration – RAID Level With No Fault Tolerance
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Logical Drives Tab 

Configure the following options (Figure 4-16) for a logical drive.

1. How many logical drives do you want to create? [1–32]

2. How much capacity do you want to use? [default=100% available 
space, or equivalent in MB]

3. Do you want to initialize logical drives? [Yes/No]

This is done after the configuration has been applied.

Figure 4-16. Assisted Configuration –Logical Drives

Certain Mylex PCI RAID Controllers allow Immediate RAID Availability of 
logical drives after configuration. For these controllers, initialization can 
take place in the background without the need to wait for full foreground 
initialization. If you selected Yes to the question above and the controller 
supports background initialization, the following screen will display (Figure 
4-17):
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Figure 4-17. Background Initialization is Supported

4. If this message appears, click Yes to request a full foreground 
initialization of logical drives once the new configuration is applied, 

OR

Click No to take advantage of the background initialization support. 
Once you’ve applied your configuration, your logical drives will be 
available for immediate use.
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Optimization Tab

Configure the following options (Figure 4-18) for optimization.

1. Choose between:

• Write cache enabled (write back)

• Write cache disabled (write through)

2. Select a Stripe Size from the valid drop-down list.

3. Select Cache line size.

Valid cache line size values depend on the stripe size settings. If the 
cache line size of 64KB is currently being used by the controller and 
you choose a stripe size that is lower than 64KB, a Warning dialog box 
will open with the following message, “Due to your selection of Stripe 
Size less than 64KB, 8KB Cache Line Size will be used.”

Figure 4-18. Assisted Configuration – Optimization
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Finish Tab

When you get to the Finish screen (Figure 4-19), do the following:

Figure 4-19. Assisted Configuration ->New Configuration ->Finish

1. Examine the Configuration Summary for details about the 
configuration that RAID Assist will set up.

2. If you want to start over, click the Welcome tab or Cancel button, OR

If you want to change your answers to any of the questions you were 
asked, click the appropriate tab to return to that screen, OR

If you want to view the configuration before it is applied to the 
controller, click the Details button. You will be taken to an equivalent 
of the Disk Arrays page as shown in Manual Configuration, except that 
you can only view and close the details window. 

3. If you accept the configuration as presented, click the Apply button at 
the Finish page to apply the new configuration to the controller.

A warning confirmation box appears as shown in Figure 4-20:
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Figure 4-20. WARNING Before Applying the Configuration

4. Type YES and click OK if you are sure you want to apply the new 
configuration and overwrite the old. If you are not sure, click Cancel.

☛ Note
In Assisted Configuration, Add Logical Drive and 
Expand Array function very similarly to the New 
Configuration option. In each case RAID Assist leads 
you step-by-step through the relevant questions for 
the task.

Manual Configuration

Manual Configuration provides four options:

• Edit Configuration. Displays the current configuration (disk arrays 
and logical drives) and allows you to add or delete a logical drive(s) 
randomly. This operation is called Random Add or Delete a Logical 
Drive(s) and does not affect any other existing logical drive data, but it 
may cause an available space to be segmented. After the edit is applied, 
if deleting a logical drive, data on the edited logical drive(s) will be 
lost.

• New Configuration. Sets up a new configuration on the controller, 
deleting the previous configuration and data (if any).

• Add Logical Drive. Sets up additional arrays (logical drives) randomly 
leaving the existing array(s) intact. At least one array must be 
configured on this controller, and unconfigured drive space must 
remain. 

• Expand Array. Restripes data in your array across additional, 
unconfigured drives to expand the capacity of the array. M.O.R.E.2 and 
RAID Level Migration functions are available here.
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• Defragment Array. Defragments unused spaces in an existing array.

For example open New Configuration as shown in Figure 4-21.

Figure 4-21. Select “New Configuration”

The Disk Arrays tab in Manual Configuration is where you begin to 
configure your unused disk drives (lower left, Figure 4-22).
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Figure 4-22. Manual Configuration – Disk Arrays

Each disk array is represented by two lines in the Disk Arrays area of the 
screen (upper left, Figure 4-22). Logical drives (if any have already been 
configured) display on the right side.

Do the following:

1. Select an unused drive and drag it to the Disk Array A0 section. The 
drive will be part of a disk array referred to as “A0.”

2. Select other unused drives and drag them to Disk Array A0, or click the 
Add Array button to create a row for Disk Array A1 (then A2, A3, 
etc.), then drag unused drives to A1 (or A2, A3, etc.) if you so desire.

☛ Note
Multiple drives can be added by holding down Ctrl 
while clicking drives, then dragging the selected set to 
a Disk Array section.

3. If you want to manually configure a hot spare, click an unused drive, 
then click the Make Spare button. If you want a dedicated hot spare, 
drag and drop the hot spare to the desired disk array.

4. If you want to start over, click the Clear All button and start again.
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5. Once you have assembled the disk array groups, click the Logical 
Drives tab to continue on to logical drive setup (Figure 4-23).

Figure 4-23. Manual Configuration – Logical Drives

The Logical Drives tab in Manual Configuration is where you configure 
your disk arrays into logical drives.

Do the following:

1. If you want to randomly create a logical drive, select the desired disk 
array from the Disk Array drop down menu.

2. Select a RAID level for your first logical drive. Supported RAID levels 
are RAID 0, RAID 1, RAID 3, RAID 5, RAID 0+1, and stand-alone 
drive (JBOD). Only RAID levels compatible with the current 
configuration will be available in the list.

3. Type the amount of available logical or physical capacity for this 
logical drive. If your total configuration will have only one logical 
drive which uses all available capacity, the default sizes should not be 
changed. If you intend to create additional logical drives now or later, 
type a smaller number to reserve the desired amount of capacity.

☛ Note
When creating a random logical drive, if there are a 
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few existing segmented spaces, the largest space is 
used to create the logical drive.

4. Check the Write Cache box if you want this logical drive to use Write 
Back caching. This improves performance but puts data at risk. You 
should have a battery backup unit or uninterruptable power supply if 
selecting this feature.

5. Check the Init Drive box if you want this logical drive to be fully 
initialized at the conclusion of the configuration. It is recommended 
that you check this option (if available), unless the controller is capable 
of background initialization. If so, and you check the box, you’ll see a 
message when you apply the configuration indicating that you can 
make use of the background initialization support.

6. Select a stripe size. The stripe size is defined as the size, in kilobytes 
(1024 bytes), of a single I/O operation. A stripe of data (data residing in 
actual physical disk sectors, which are logically ordered first to last) is 
divided over all disks in the drive group. 

When selecting a stripe size of less than 64KB, the active cache line 
size will change from 64KB to 8KB. A Warning message box will open 
when you click the Apply button to complete your configuration (see 
Figure 4-24).

Figure 4-24. Stripe Size Selection Warning

If you select Yes, the new configuration will be applied and an 8KB 
cache line size will be active.

If you select No, the Logical Drives page of the Manual Configuration 
Wizard will open. You can change the stripe size in order to obtain the 
desired cache line size.

7. Select a cache line size, if enabled. Available settings will depend on 
the selected stripe size.
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8. Click the Add Drive button to register your new logical drive.

9. Click Apply to save the configuration if you are finished setting up 
logical drives, OR

Repeat the process above to set up additional logical drives, then click 
Apply when you’re done.

An example of a completed Manual configuration is shown in Figure 4-25:

Figure 4-25. Sample Manual Configuration Just Before “Apply”

☛ Note
In Manual Configuration, Add Logical Drive and 
Expand Array function very similarly to what was 
shown above. In each of these two cases, however, 
RAID Assist shows you the disk arrays and logical 
drives and allows you to add to the configuration 
without risking existing data.
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Global Hot Spares vs. Dedicated Hot Spares
A hot spare is classified as two types: 1) a Dedicated Hot Spare and 2) a 
Global Hot Spare. Dedicated Hot Spares belong to a single disk array or 
spanned disk array. Global Hot Spares do not belong to specific disk arrays, 
but are available for all disk arrays within Private or Shared channel 
boundaries.

To create a Global Hot spare, use the following procedure:

1. Open RAID Assist by clicking Administration->RAID Assist on the 
menu bar or the RAID Assist icon as shown in Figure 4-7.

2. The RAID Assist “Welcome” dialog box displays (Figure 4-8).

3. Click the Manual Configuration button.

4. Click the Edit Configuration button.

5. Click the Disk Array tab.

6. Select a physical drive in Unused Disk Drives/Global Hot Spares pane.

7. Click the Make Spare button.

A Global Hot Spare is created, and a white plus sign indicates the 
physical disk drive has changed to a Global Hot Spare 
(see Figure 4-26).

Figure 4-26. Creating a Global Hot Spare
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8. If you want the Global Hot Spare to be a Dedicated Hot Spare drag and 
drop it to the disk array that the Global Hot Spare belongs (see
Figure 4-27).

Figure 4-27. Creating a Dedicated Hot Spare

A Dedicated Hot Spare is created, and a green plus sign indicates the 
physical disk drive has changed to a Dedicated Hot Spare 
(see Figure 4-27).
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Expand Capacity
GAM provides an advanced configuration mode known as MORE2 (Mylex 
Online RAID Expansion 2) which provides two features, Online Capacity 
Expansion and Extension (OCE), and RAID Level Management (RLM). 
These features allow you to increase the capacity of a RAID array in a 
variety of ways. All of the following operations are available while the 
controller is online. The operations are performed in the background while 
normal data operations occur.

• Add a physical drive or drives to the system

• Add a logical drive to the system

• Increase the size of a logical drive or drives in the system

• Change RAID level on a logical drive or drives

MORE2 operations have the following restrictions:

• no channel swapping during more operation

• no operation on a spanned array 

• result configuration group may not exceed 16 physical disks

☛ Note
Although OCE and RLM operations are explained 
separately in the following sections, these operations 
may be combined.

Expanding a Logical Drive

Online Capacity Expansion is the ability to increase the size of a logical 
system drive while normal reads and writes occur. The expansion can be 
obtained by adding one or more physical drives to the system, changing the 
RAID level and/or increasing the amount of space on the physical drives 
allocated to the logical drive.Only one logical drive can be created per the 
Expand operation. When performing this operation, you cannot change the 
write cache, init drive, or strip size of an existing logical drive.

Added capacity amounts are rounded up to the next whole megabyte on the 
physical drives. This means that the space is allocated on the physical drives 
with one megabyte granularity.
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To expand a logical drive, follow these steps:

� Caution
It is highly recommended that you backup your 
current configuration before making modifications.

1. Select Administration->RAID Assist on the menu bar or the RAID 
Assist icon (see Figure 4-7).

2. Click the Manual Configuration button.

3. Click the Logical Drives tab, this is where you can add capacity.

Figure 4-28. Expand Capacity – Logical Drives Tab

4. Click on the Add Drive button to add a logical drive(s). If there are a 
few available segmented spaces, the largest space is used for the 
creation of a new logical drive.
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Figure 4-29. Expand Capacity – Add Logical Drive(s)

5. Select a RAID level for your new logical drive. 

6. Type the desired amount of available logical or physical capacity for 
this logical drive.

7. Check the Write Cache box if you want this logical drive to use Write 
Back caching. This improves performance but puts data at risk. You 
should have a battery backup unit or uninterruptable power supply if 
selecting this feature.

8. Check the Init Drive box if you want this logical drive to be fully 
initialized at the conclusion of the configuration. 

9. Select a stripe size.

10. Select a cache line size, if enabled. Available settings will depend on 
the selected stripe size.

☛ Note
Only a newly created logical drive can be deleted. 
Select the logical drive by a right mouse click, then 
click the Delete Drive button.
4-32 GAM Client User’s Guide



Configuration
11. Click the Apply button to save your new configuration.

A message box appears as shown in Figure 4-30, 

click Yes to proceed:

Figure 4-30. Message Before Applying the Configuration

A warning confirmation box appears as shown in Figure 4-31

Figure 4-31. WARNING Before Applying the Configuration

12. Type YES and click OK if you are sure you want to apply the new 
configuration and overwrite the old. 

� WARNING
Expand Capacity cannot be cancelled.

The Expand Capacity Status box (Figure 4-32) opens and displays the 
progress of a disk array capacity expansion.
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Figure 4-32. Expand Capacity Status Box

Click Close to close the Expand Capacity Status box at any time. Click 
View-> Expand Capacity Status to open the status box at any time.
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Migrating a RAID Level

RAID Level Migration is the ability to change the RAID level on one or 
more system drives. This may require more or less space on the physical 
drives. Any other logical drives are moved to make room for the size change. 
This includes moving system drives to remove gaps between the system 
drives that either exist before migration or those that would be a result of the 
migration.

The following table (Table 4-1) describes the allowed migrations.

To migrate a RAID level, follow these steps:

1. Select Administration->RAID Assist on the menu bar or the RAID 
Assist icon (see Figure 4-7).

2. Click the Manual Configuration button.

3. Click the Logical Drives tab, this is where you can edit a RAID level.

4. Follow Step 5 through Step 12 of “Expand Capacity” on page 4-30.

Table 4-1. RAID Level Migration Options

Starting RAID level Destination RAID level

0 0,  3, 5, 0+1

1 1, 3, 5, 0+1

3 3, 5, 0+1

5 3, 5, 0+1

0+1 3, 5, 0+1

JBOD 0, 1, 3, 5, 0+1
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Transporting a Disk Array
You can transport a disk array group between any single controller to any 
dual controllers and vice versa. However, it may not be easy for you to know 
which disk drives in an enclosure belongs to which specific disk array. To 
help you, the locate function is expanded to indicate visually all disk drives 
(dedicated hot spares and global hot spares are not included) that belong to a 
specific disk array by using LEDs.

To locate a disk array for transportability, use the following procedure:

1. In the Controller View Window, double click a logical drive.

2. The Logical Drive Information Window opens (see Figure 4-33).

Figure 4-33. Logical Drive Information Window – Transport Button

☛ Note
Clicking the Locate button in the Logical Drive 
Information window (Figure 4-33) turns on LEDs on 
all of the physical drives belonging to the disk array 
excluding the global or dedicated hot spares.
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3. Click the Transport Button, the Disk Array Transport Information 
Window opens (Figure 4-34).

Figure 4-34. Disk Array Transport Information Window

All of the physical drives including the global and dedicated spares 
associated with the selected logical drive and all of the logical drives 
that belong to the same disk array are displayed.

Click the Locate Transport button to turn on LEDs on all of the physical 
drives including the global hot and dedicated hot spares that belong to the 
disk array for visual indication. 

You are now ready to transport your physical drives.
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Clustering & Teaming
In a clustered RAID environment, multiple controllers share the same back 
end SCSI disk drives through a SCSI or Fibre channel cable(s). If the 
controllers reside on different systems respectively, it is called clustering. A 
clustering software manages the clustering configuration. If controllers 
reside on the same system, it is called teaming. PATHpilot Pro manages the 
task of teaming by allowing monitoring and manipulation of paths. GAM 
provides the following information:

• Servers participating in the cluster configuration

• Controllers that are part of the cluster configuration

• Channels on each cluster that share backend disk drives

Select View->Cluster Map to open the Cluster Map Window (Figure 4-35).

Figure 4-35. Cluster Map

The Cluster Map dialog box displays a graphical backend cable 
connection for the controller selected from the Cluster Controller list. 
Channels on the cluster controllers connected by a colored line are 
shared channels where disk drives are shared. Private channels are 
shown without any connection. In Figure 4-35, four controllers are 
connected by three shared cables. If these four controllers reside on 
different controllers respectively, it is called four nodes clustering. To 
show a server or IP address for each node, the four servers should be 
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registered as a single server group through the 
Administration->Define Server Groups dialog box (see “Setting Up 
Server Groups and Servers” on page 3-17). The colors of the lines have 
no relation to other color indications (e.g. channel colors).

To launch PATHpilot, click Administration->Advanced Functions
->PATHpilot. The PATHpilot Information Control Console (PIC) will 
start as a separate application. (The information in Figure 4-36 is for 
demonstration purposes.)

Figure 4-36. PATHpilot Information Control Console (PIC)

The PIC screen consists of a multi-frame viewer, menu bar, tool bar, 
and status bar. Refer to the PATHpilot Online Help for complete 
descriptions of Navigation tools and Configuration settings.
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Managing Channels
To avoid future “Boot Failure” as result of disk array creation across 
channels after performing a clustering configuration, a channel that a 
physical disk belongs will be specifically indicated. The following colors 
combinations will be used per channel:

• Channel 0: Orange

• Channel 1: Violet

• Channel 2: Cyan

• Channel 3: Lavender

☛ Note
The use of color combinations is being researched. 
The channel colors listed are subject to change.

A channel that is not shared with any other controller is called a Private 
channel. A channel that is shared with cluster nodes is called a Shared 
Channel. To indicate the type of channel, the following colors of text are 
used:

• Private Channel: black text in normal font

• Shared Channel: blue text in italic font

For example, Figure 4-37 shows the Disk Array tab where a controller has 
four channels. Channel 1 is a shared channel and other three channels are 
Private channels. Because Channel 1 is a shared channel, all text associated 
with the channel are blue and italicized (physical disk numbers, an array 
number, and a logical number). 
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Figure 4-37. Disk Array Tab – Four Channels Displayed

Figure 4-38 shows the Controller View window displaying four channels.

Figure 4-38. Controller View – Four Channels Displayed

When an attempt is made to create a disk array across channels, the caution 
message in Figure 4-39 opens. The message does not inhibit this operation, 
click the OK button to continue or click Cancel to end the operation. When 
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GAM Client is running, this message will display once at the first attempt.

Figure 4-39. Caution – Mixing Channels

If intermixing between Private and Shared channel happens during 
configuring, the operation is inhibited and a warning message (Figure 4-40) 
is displayed.

Figure 4-40. Warning – Mixing Channels
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Spanning in Global Array Manager
Spanning allows you to configure multiple drive packs or parts of multiple 
drive packs as one system drive. This means that space is used from the first 
array to the last identical array.

A drive pack is a group of individual disk drives (preferably identical) that 
are logically tied to each other and are addressed as a single unit. In some 
cases this may be called a drive “pack” when referring to just the physical 
devices.

All physical devices in a drive group should be the same size; otherwise, 
each of the disks in the group will have the capacity of the smallest member. 
The total size of the drive group will be the size of the smallest disk in the 
group multiplied by the number of disks in the group. For example, if you 
have four disks of 400MB each and one disk of 200MB in a pack, the 
effective capacity available for use is only 1000MB (5x200), not 1800MB.

Drive packs or groups have the following properties.

• From one to sixteen disk drives included in an individual drive pack or 
group. 

• The drive pack can include physical disk drives located on different 
drive channels.

• The number of disk drives in a drive pack determines the possible 
RAID level. To create a JBOD or RAID 0, RAID 1, RAID 3, RAID 5, 
RAID 0+1 use the following table (Table 4-2):

Table 4-2. Configuring a Spanned Array

After physical disk drive packs are defined, one or more system drives may 
be created from drive packs. System drives have the following properties:

RAID Level Minimum 
number of 

Drives

Maximum 
number of 

drives

Maximum 
number of 
drives with 
Spanning 
enabled

Theoretical 
Maximum 
number of 

drives

1 2 16 112 256

2 2 2 32 32

3 3 16 112 256

4 3 16 112 256

5 3 16 112 256

0+1 1 1 16 16
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• In GAM more than one system drive can be defined on a single drive 
pack; a system drive can also span 16 packs.

• The minimum size of a system drive is 8MB. The maximum is 2 TB.

• Up to 32 system drives can be created. Each system drive has its own 
write policy (write-back or write-through).

Enable Spanning in GAM
1. Using a text editor application (such as Notepad), open the gam2cl.ini 

file.

2. Scroll to the Enable_System_Drive_Span=0 parameter and set the 
parameter to 1 (default value =0).

3. Save and close the gam2cl.ini file.

Configuring a Spanned Disk Array
1. Open RAID Assist by clicking Administration->RAID Assist on the 

menu bar or the RAID Assist icon as shown in Figure 4-7.

2. The RAID Assist “Welcome” dialog box displays (Figure 4-8).

3. Click the Manual Configuration button.

4. Click the Edit Configuration button. 

☛ Note
Automatic and Assisted configuration options do not 
allow spanning.

5. To create a JBOD or RAID0 connect at least four drives of the same 
size to a controller. To create a RAID 1, RAID 3, RAID 5, or 
RAID 0+1, connect at least six drives of the same size to a controller. 

Select physical drives from the drive packs to create a spanned array. 
Remember to use the same number of devices in each Array or 
spanning will not be utilized. Figure 4-41 shows the creation of two 
arrays each having three equal sized disk drives.
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Creating a Spanned Disk Array

☛ Note
Spanned disk arrays cannot be created across a 
Private and Shared channel.

1. Click on the Disk Arrays tab.

2. Click on the Add Array button to add the desired number of arrays. 
Each time you click the Add Array button, an array will be added to 
your configuration (A1, A2, A3, etc...). For this example, assume that 
A0 has been configured before adding new arrays.

☛ Note
Multiple drives can be added by holding down Ctrl 
while clicking drives, then dragging the selected set to 
a Disk Array section.

3. In the Unused Disk Drives/Global Hot Spares (MB) pane, drag and 
drop the available disk drives to the appropriate disk array (A0, A1, 
etc...). See Figure 4-41.

Figure 4-41. Creating a Spanned Array

You can now configure the desired amount of logical drives.

Select the Logical Drives tab to configure your disk arrays into logical 
drives. It works the same as Manual/New (see “Manual Configuration” on 
page 4-22). Note that the only logical drives that will be spanned are those 
whose capacity is taken from more than 1 array.
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Loading a Configuration from Disk
Load a previously-saved configuration from disk as shown in Figure 4-42.

Figure 4-42. Select “Open Configuration”

1. In the Open Configuration dialog box (Figure 4-43), select the 
configuration file you wish to open to save to the controller.

Figure 4-43. Open Configuration Dialog Box

2. Click Open to access the configuration file.

Changing the configuration is data destructive. A warning message 
appears (Figure 4-44):

Figure 4-44. Open Configuration Warning Message
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3. To confirm your decision to overwrite the existing configuration, type 
YES then click OK, or

Click Cancel to stop without applying the saved configuration.

Saving a Configuration to Disk
Saves a configuration file to a new filename, disk, and/or directory.

Figure 4-45. Select “Save Configuration”

1. In the Save Configuration dialog box (Figure 4-43), type a name for the 
configuration file you wish to save.

Figure 4-46. Save Configuration Dialog Box

2. Click Save to save the configuration file.

The configuration file (.gcf) will be saved.
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Monitoring
Introduction
Monitoring activities involve the following:

• Monitoring events (messages) sent by various servers to the client 
workstation(s).

• Monitoring controller activity; reviewing controller configuration and 
other information.

• Reviewing physical device and logical drive information.

• Viewing Bad Block Data, Request Sense Data, and NVRAM Log Data.

• Monitoring and managing SCSI and Fibre enclosure information.

• Monitoring the performance of drives and controllers; reviewing 
historical performance data (Statistics View and Performance 
Analysis).

• Monitoring the status of ongoing processes, such as initialization, 
rebuild, consistency check, expanding capacity of an array, and Patrol 
Status.

• Monitoring the status of an Intelligent Battery Backup Unit (BBU), and 
recharging/reconditioning the battery if needed (new PCI controllers 
only).
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Event Monitoring
The Global Array Manager Server driver subcomponent monitors activity 
and performance of all devices and controllers attached to the server. When 
an identified activity occurs which results in an “event” (whether severe, 
such as a hard disk failure, or informational, such as assignment of a drive to 
hot spare status), the event is sent to selected workstations running GAM 
Client.

Events are displayed in the Log Information Viewer. An “event” can be any 
of the following:

• Server attach and detach (Guest, User, and Administrator)

• Error or warning condition in a RAID subsystem (such as a power, fan, 
or drive failure)

• Any administrative activity (taking a drive off-line, killing, or 
rebuilding a drive)

☛ Note
It is recommended that the Global Array Manager 
Client be kept active.

Opening the Log Information Viewer

The Log Information Viewer is opened when the program is started and one 
or more controllers are detected (see “Components of the Log Information 
Viewer” on page 3-4). The viewer displays the contents of gam2cl.log, an 
ASCII text file. This file contains a chronological log of all the events that 
occur while this session of the program is executing. By default, the log file 
is named gam2cl.log. The log file name and location can be changed on the 
Alert Preferences page or in the gam2cl.ini file.

Opening an Event Information Window

If you wish to obtain additional information about any event displayed in the 
Log Information Viewer, the program allows you to open an event 
information window. Appendix A documents the entire list of event 
descriptions, causes (details), and actions.

To open the event information window for a particular event:
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1. Check that the Log Information Viewer is displayed.

2. Determine which event you would like more information about (scroll 
the Log Information Viewer if necessary), and double-click anywhere 
along the event line (or double-click in the Event ID field).

An event information window for your selected event is displayed. An 
example is shown in Figure 5-1:

Figure 5-1. Event Information Window

A variety of information about the event is displayed to aid in 
troubleshooting. The Event ID and Severity Level are displayed in the 
window’s titlebar. SOURCE, DEVICE ADDRESS, and 
DESCRIPTION redisplay information from the original event line.

The most useful fields are:

• CAUSE. Possible reasons that the event occurred, and

• REQUIRED ACTION. What you should do in response to this 
message. Informational messages will most likely have no required 
actions. Critical, Serious, Error, and Warning messages may specify 
useful required actions.

3. Click OK to close the event information window.
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Controller Monitoring
After a client and server connection is made through sign-on, the GAM 
Client opens a window for each RAID controller, SCSI HBA, and their 
drives operating in that file server. These controller windows are the Global 
Array Manager Client’s Controller View (see “Components of the Controller 
View Window” on page 3-5 for a detailed description). 

Displaying Controller Information

Open Controller Information by clicking Administration->Controller 
Information on the menu bar or the Controller Information icon as shown in 
Figure 5-2:

Figure 5-2. Select “Controller Information”

Figure 5-3 shows the Controller Information window for a PCI RAID 
Controller.
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Figure 5-3. Controller Information

The following information is displayed:

• The controller model

• Whether an Intelligent Battery Backup Unit is installed (N/A for not 
supported on the current controller)

• The firmware and BIOS versions residing on the controller

• The cache size and FlashROM size

• The bus type and number of channels on the controller

• The number of physical devices detected, and the maximum number of 
physical devices that this controller can hold

• The number of logical drives configured on this controller, and the 
maximum number of logical drives that can be configured

• Host information: bus number, slot number, and IRQ

Click the Controller Options button to view a dialog box of user-definable 
controller parameters (see “Setting and Modifying Controller Options” on 
page 4-2).

Click the Close button to close the Controller Information window.
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Physical Device and Logical Drive Monitoring
This section describes how the Global Array Manager Client monitors 
physical devices and logical drives.

Displaying Device Information

The Controller View window details which physical devices are associated 
with each controller channel. Each stack of drives represents the physical 
drives connected to a single channel on the controller.

A physical device can be a host controller, a CD-ROM drive, disk drive, tape 
drive, etc. Double-click a physical device icon to display information about a 
particular physical device.

Figure 5-4. Host Device Information – RAID Controller
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Figure 5-5. Disk Device Information

Device Information (Figure 5-4, Figure 5-5) displays the following about the 
currently-selected physical device.

Device Information: RAID Controller

• The vendor or source of the controller

• The controller’s product identification

• The revision level of the hardware

• The back-end bus width (in bits)

• Whether the following parameters are set to Yes or No: Sync, Soft 
Reset, Command Queuing

• ANSI Version supported

• Back-end transfer speed and bus width (device state)

Device Information: Disk Drivek Drive

• The vendor or source of the drive

• The drive’s product identification (such as ATLASIV9WLS)
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• The revision level of the firmware in the drive

• The back-end bus width (in bits)

• Whether the following parameters are set to Yes or No: Sync, Soft 
Reset, Linked, Command Queuing

• ANSI Version supported
• MRIE Mode

• Disk drive serial number
• The physical capacity of the disk device in MB
• The back-end negotiated transfer speed (MB/sec) and back-end 

negotiated bus width
• The “configured” size of the disk device in MB
• Sector size (usually 512 bytes)
• The current status of the disk (online, offline, etc.) and a failure 

indicator if the disk drive has failed (refer to Appendix A for a list of 
error codes)

• The number of soft, hard, parity, and miscellaneous errors registered
In the disk drive Device Information dialog box...

Click the Reset Errors button to return all error tallies to 0.

If the disk drive’s status is Rebuild, the Rebuild button may be available so 
that you can initiate a physical device rebuild.

If the physical device is unconfigured, the Make Ready button may be 
available to make this device disk available for configuration. You will then 
need to go to RAID Assist to configure the device disk (see “Running RAID 
Assist” on page 4-9).

If the disk drive’s status is dead, you will see a failure indicator display on 
the Device Information page in the Device State section.

Make Online and Make Offline buttons should be used with great caution. 
Refer to the online help file, or call IBM for support on these options.

The Locate button allows you to locate this physical device visually (only 
for new Mylex PCI controllers):

1. Click the Locate button.
The LED of the physical disk will blink to reveal its location.
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☛ Note
LEDs associated with global or dedicated spares will 
not blink.

Figure 5-6. Locate Device Message

2. Click OK (see Figure 5-6) to end the locate operation and return to 
normal status.

The PFA Count shows the amount of device errors registered. Click the PFA 
Information button to display the PFA sense code details (Figure 5-7).

☛ Note
The PFA button will not be visible if the PFA count is 
zero.

Figure 5-7. PFA Information Window

Click the Close button to close the window.
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Viewing the Request Sense Data and NVRAM Error Log

Open the Error Table by clicking View->Error Table on the menu bar or the 
Error Table icon as shown in Figure 5-8.

Figure 5-8. Select “Error Table”

If you click the Request Sense Data tab, the following type of information 
appears (Figure 5-9):

Figure 5-9. Request Sense Data

This information may be useful for troubleshooting or later analysis.
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1. Click Save File to record the request sense data for later use. The .rsd 
file can be saved to a floppy disk or your hard drive.

2. Click Read File to open and view a .rsd file that was previously saved.

3. Click Close to close the Error Table.

For new PCI controllers, a tab for NVRAM Error Log will be added 
(Figure 5-10):

Figure 5-10. NVRAM Error Log

Similar to the event log in the controller memory, the error event logged in 
the NVRAM has the following types:

• Generic event: it records all activity changes, i.e. disk drive offline, 
logical created/deleted, etc.
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• Request Sense: Also referred to as 'Error Events', this records only 
error activity in the form of vendor unique SCSI request sense format 
for Mylex errors or actual SCSI request sense from physical device, i.e. 
rebuild failed, consistency check failed, deferred write error, etc.

• Additional events that normally output through serial debugging port 
but are critical for failure analysis will be logged too. For example, 
power cycling, PCI bus error, abnormal SCSI bus behaviors etc. 

☛ Note
The controller does not have Real Time Clock (RTC) 
data, therefore, events logged by the controller before 
you start Windows 2000 will display a relative time 
stamp.This is a time value that is set when the 
controller is powered on. See Figure 5-10.

Events logged by the controller after you start 
Windows 2000 will display an absolute time stamp 
(date and time). This is a time value that the controller 
driver sets when Windows 2000 is started.

The following describes the button functions for the NVRAM Error Log:

• To save data for failure analysis that can be used for troubleshooting, 
click the Save File button to record the NVRAM Error data for later 
use.

• To clear the NVRAM Error Log, click the Clear Log button.
• When new NVRAM errors are logged, click the Refresh button.
• To update the NVRAM Error Log with the latest errors from the 

controller, click the Refresh button.
• Click Close to close the Error Table.
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Displaying Logical Drive Information

The icons on the right side of the Controller View window represent the 
logical drives (also known as logical units or system drives) created by the 
controller out of the available physical drives.

Double-click a logical drive icon to display information about a particular 
logical drive (Figure 5-11).

Figure 5-11. Logical Drive Information for a RAID Controller

Logical Drive Information displays the following about the currently-
selected logical drive:

• The logical drive number (in the window’s titlebar)
• The RAID level at which the logical drive is configured
• Whether the logical drive’s configuration is optimized for speed, 

optimized for capacity, and fault tolerant [Yes/No]
• The logical and physical size of the logical drive
• The stripe size and cache line size in use by the logical drive
• Whether write back cache is enabled or disabled
• The operational status of the logical drive
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• Out of the total amount of capacity configured on the controller, the 
amount of capacity held by this logical drive (shown in a bar graph)

If write back cache is disabled, click the Enable Write Cache button to 
enable the cache.

If write back cache is enabled, click the Disable Write Cache button to 
disable the cache (and use write through caching).

If the Consistency Check button is enabled, you may manually run a 
consistency check on this logical drive (as discussed in the next chapter).

Click Show Bad Data Blocks to display a window of all bad data blocks 
found on this logical drive.

If the logical drive has been placed offline due to some external cause such 
as a power failure, click Force On Line to return the logical drive to an active 
state. A warning window appears asking for confirmation of the force online 
procedure.

� Caution
Forcing a logical drive online should only be done in 
a power failure recovery situation. Doing so at any 
other time may result in data loss.

The Locate button allows you to locate the physical devices visually that 
comprise this logical drive (only for new Mylex PCI controllers).

1. Click the Locate button.

The LED(s) of the physical disk(s) will blink to reveal their location.

☛ Note
LEDs associated with global or dedicated spares will 
not blink
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.

Figure 5-12. Locate Device Message

2. Click OK (see Figure 5-12) to end the locate operation and return to 
normal status.

3. Click the Close button to close the dialog box.

The Transport button opens the Disk Array Transport Information window 
that shows all of the physical drives, including the spares associated with the 
selected logical drive, and all of the logical drives that belong to the same 
disk array. See “Transporting a Disk Array” on page 4-36 for details.
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Enclosure Monitoring and Management
The Controller View window contains an Enclosure button with a status 
light. The Green square indicates OK, the Yellow circle indicates Critical 
status, and a Red X indicates failed status. You can monitor information, 
status, and additional details about enclosures by clicking the Enclosure 
button in Controller View. Alternatively, you can select Enclosure 
Information from the Administration menu as shown in 
Figure 5-13.

Figure 5-13. Select “Enclosure Information”

The Enclosure Information dialog box is displayed with the Information 
page active (Figure 5-14).
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Figure 5-14. SES Enclosure Information – Information Page

Information Page

Enclosure Information displays the following about the currently-available 
enclosures:

• The status of each enclosure, identified by an icon and an enclosure 
number (1–32)1, as well as one of the following expressed in text:

• OK – All components are optimal.

• Critical – Some component has failed; one more failure may result 
in data loss.

• Failed – A failure has occurred that may result in data loss.

• The enclosure type (SES, SAF-TE).

• The World Wide Name or Inquiry (WWN/INQ) for the enclosure:

• For SES – The World Wide Name as 8 hex bytes.

• For SAF-TE – The first 8 bytes of the Inquiry command’s data.

• The vendor identification.

1. An undetermined enclosure shows as a zero (0). In this case, all 
information is presented as if there is a single enclosure with all 
the fans, power supplies, etc.
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• The product identification.

• The product revision level.

• The number of drive slots in the enclosure cabinet.

Highlight an enclosure and the Locate button will become available. Click 
the Locate button to “blink” the LEDs of all of the physical drives in the 
enclosure to reveal its location. A locate enclosure dialog box will open, 
click OK or press the Enter key to end the locate operation.

Click the Close button or press the Enter key to close the dialog box.

Details Page

Select the Details Tab to display Enclosure Information Details 
(Figure 5-15).

Figure 5-15. SES Enclosure Information – Details Page

Enclosure Information Details page displays the following about the 
currently-available Fibre enclosures:

The status of each enclosure, identified by an icon and an enclosure number, 
as well as one of the following expressed in text:

• OK – All components are optimal.
• Critical – Some component has failed; one more failure may result 

in data loss.
• Failed – A failure has occurred that may result in data loss.
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The access status of each enclosure, which indicates the controller’s ability 
to communicate with the enclosure. The status values are:

• OK – Access is optimal.
• Critical – Only one access path remains of the several that were 

detected previously. If the last access path is lost, the controller will 
take steps to protect the data.

• Lost – The enclosure is unreachable by the controller. Any failures 
in the enclosure while this state exists will not be sensed by the 
controller.

The speed of the fans in the enclosure. Each fan is designated with a number, 
the values are:

• Absent – The fan is not installed, or has failed in an undetectable 
way.

• OK – The fan is optimal. Fan speed is shown as either Stopped, 
Low, or High. (Speed is not shown for SAF-TE enclosures.)

• Failed – The fan is installed, but has failed.

The status of the power supplies in the enclosure. Each power supply is 
designated with a number. The status values are:

• Absent – The power supply is not installed, or has failed in an 
undetectable way.

• OK – The power supply is optimal.

• Failed – The power supply is installed, but has failed.

The status of the temperature sensors in the enclosure. Each temperature 
sensor is designated with a number. The status values are:

• Absent – The temperature sensor is not installed, or has failed in an 
undetectable way.

• OK – The temperature sensor is optimal. Two additional items are 
displayed with this state: Celsius Temperature (range for SES is -19º 
to +235º; range for SAF-TE is -10º to +245º); Over Temperature 
Warning (OT).

• Failed – The temperature sensor is installed, but has failed.

The status of the alarms in the enclosure. Each alarm is designated with a 
number, the status values are:
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• Absent – The alarm is not installed, or has failed in an undetectable 
way.

• OK – The alarm is optimal. One additional item is displayed with 
this state: ON – the alarm is currently on or sounding.

• Failed – The alarm is installed, but has failed.

The status of the enclosure’s connection to one or more Uninterruptable 
Power Supplies (UPS). Each UPS is designated with a number. The status 
values are:

• Absent – The UPS is not installed, or has failed in an undetectable 
way.

• OK – The UPS is optimal. Three additional items are displayed with 
this state: AC Pwr – the UPS is reporting an AC power failure; DC 
Pwr – the UPS is reporting a DC power failure; Low Bat – the UPS 
can power the system for only 2 to 5 more minutes.

• Failed – The UPS is installed, but has failed.

Error status for troubleshooting purposes. Error status for an enclosure is 
reported in a format similar to the following example:

0 Addressing 25 02:03 04:05

• 0 is the error number.

• Addressing is the error type.

• 25 is the ALPA (Arbitrated Loop/Port Address) of the drive in 
question.

• 02:03 is the first known channel and target to which the ALPA is 
mapped.

• 04:05 is the second known channel and target to which the ALPA is 
mapped.

An information field which contains most of the items listed on the 
Information page for easier cross-reference.

Highlight an enclosure and the Locate button will become available. Click 
the Locate button to “blink” the LEDs of all of the physical drives in the 
enclosure to reveal its location. A locate enclosure dialog box will open, 
click OK or press the Enter key to end the locate operation and return to 
normal status.
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Click the Close button or press the Enter key to close the dialog box.

SCSI Enclosures

Among the stack of drives displayed in a channel tower of the Controller 
View window, you will find an enclosure depicted. Its icon looks something 
like this: 

Double-click the enclosure icon to display enclosure information about the 
enclosure icon (Figure 5-16).

Figure 5-16. Processor Device (Enclosure) Information: SCSI

Processor Device Information displays the following about the currently-
selected enclosure/processor:

Processor/Enclosure Information: SCSI

• Device Inquiry Data information, such as vendor, product, product 
revision, bus width, etc.

• Device State information, such as transfer speed and bus width

Click the Close button to close the dialog box.
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Process Status Monitoring
This section describes the various ways to monitor long operation tasks.

Background and Foreground Initialization Status

While background or foreground initialization is performed, open the 
Background or Foreground Initialization Status box as shown in Figure 5-17 
to monitor the progress of or cancel the process. 

Figure 5-17. Foreground Initialization Status Shown

Figure 5-18. Foreground Initialization Status Box Shown

The Initialize Status box (Figure 5-18) displays the progress of one or more 
full logical drive initializations.

To cancel ALL Foreground drive initializations at the same time...
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Click the Select All button, which selects all drives for cancellation, then 
click Cancel to stop all the initializations.

To cancel individual drive initializations...

Check the box(es) of the drive(s) to cancel, then click Cancel to stop only 
those initializations.

If all drives are selected for cancellation and you wish to reverse that...

1. Click the Clear All button, which deselects all drives for cancellation.

2. Click Close to close the Initialize Status box at any time.

Rebuild Status

If a rebuild process is currently underway, open the Rebuild Status box as 
shown in Figure 5-19 to monitor the rebuild progress or cancel the process.

Figure 5-19. Select “Rebuild Status”

The Rebuild Status box (Figure 5-20) displays the progress of a physical 
drive rebuild. The command rebuilds all logical drives that occupy any 
portion of the targeted physical drive.
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Figure 5-20. Rebuild Status Box

Click Cancel to stop the rebuild. You may need to check the Views menu to 
see if Rebuild Status is still enabled. If so, you may need to cancel other 
rebuilds as well.

Click Close to close the Rebuild Status box at any time.

Consistency Check Status

If a consistency check process is currently underway, open the Consistency 
Check Status box as shown in Figure 5-21 to monitor the consistency check 
progress or cancel the process.

Figure 5-21. Select “Consistency Check Status”

The Consistency Check Status box (Figure 5-22) displays the progress of a 
logical drive consistency check.
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Figure 5-22. Consistency Check Status Box

Click Cancel to stop the consistency check. You may need to check the 
Views menu to see if Consistency Check Status is still enabled. If so, you 
may need to cancel other consistency checks as well.

Click Close to close the Consistency Check Status box at any time.

Expand Capacity Status

If an expand array (also called “MORE2”) process is currently underway, 
open the Expand Capacity Status box as shown in Figure 5-23 to monitor the 
progress of this process. This status box is also used to monitor a 
defragmentation. 

Figure 5-23. Select “Expand Capacity Status”

The Expand Capacity Status box (Figure 5-24) displays the progress of a 
disk array capacity expansion or defragmentation.
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Figure 5-24. Expand Capacity Status Box

� WARNING
Expand Capacity cannot be canceled.

Click Close to close the Expand Capacity Status box at any time.

Patrol Status

To monitor the Patrol Read Status, open the Patrol Status box as shown in 
Figure 5-25.

Figure 5-25. Select “Patrol Read Status”

The Patrol Read Status dialog box displays (Figure 5-26). You can start the 
Patrol Read operation from the point it was stopped. If it was never enabled, 
the Patrol Read operation will start from the beginning. This feature will 
enable the GAM Client to poll every 1 minute to get new status data from the 
controller.
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Once you click on the Start button to begin the Patrol Read operation, the 
Start button will change to Stop. Click the Stop button to end Patrol Reading.

Figure 5-26. Patrol Read Status Dialog Box
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Battery Backup Unit Monitoring and Maintenance
If your controller is equipped with an Intelligent Battery Backup Unit 
(BBU), you will be able to open the BBU dialog box as shown in 
Figure 5-27:

Figure 5-27. Select “Intelligent BBU”

Figure 5-28 shows the Intelligent BBU window for new Mylex PCI RAID 
Controllers.

Figure 5-28. Intelligent BBU – New PCI Controllers

The Intelligent Battery Backup Unit (BBU) dialog box is used to monitor 
and charge or recharge the backup battery pack on the controller. This 
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battery pack maintains the controller's data in RAM in case AC power is lost 
to the disk storage system. When a new battery is needed, the BBU dialog 
indicates this by showing the battery can no longer take or hold a charge. 
This dialog box is also used after an old battery pack is replaced with a new 
one. The new battery must be fully discharged before it can be charged up.

Prior to beginning normal operations, IBM recommends that you condition 
the battery for maximum longevity. See “Conditioning the Battery” on page 
5-31.

Power Levels

The Power Levels area of the Intelligent Battery Backup Unit dialog box 
contains the following:

• Low Power Threshold. A preset or modifiable power level, expressed 
as hours or minutes of charge, used to trigger an alarm when the battery 
power level drops below the set value. Set a threshold, select “Set Low 
Power Threshold” under Actions, then click Apply to set the new 
value.

• Current Power. The current power level of the battery expressed as 
hours or minutes of charge. This value will change as the battery is 
discharged or charged.

• Maximum Power. The highest level the battery has been charged up to 
expressed as hours or minutes of charge. This value will change as the 
battery ages and is reconditioned. The older the battery gets, the less 
charge it can contain.

• % Charge Level. The battery's charge level, where 100% means the 
battery has been charged up to its maximum level.

• Display: Minutes. Displays power values in minutes.

• Display: Hours. Displays power values in hours and tenths of hours.

• Refresh. Updates the Power Levels and Battery Status groups. It is 
useful during a lengthy operation such as a recondition to update the 
dialog without leaving it and re-entering.

Battery Status

The Battery Status area of the Intelligent Battery Backup Unit dialog box 
contains the following:
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• Battery Type. The battery pack type. Available options are Ni-Cad or 
Unknown.

• Version. Version number for the controller. Version selection numbers 
are from 0 to 255. The version number used for the first release is 1 for 
the controller production release.

The following are read-only checkbox items which indicate the battery 
status:

• Low Power Alarm. A low power condition exists as defined when the 
Current Power value drops below the Low Power Threshold value.

• Never Reconditioned. Battery has not been fully discharged before it 
was charged up. A new battery will have this checked until it has been 
fully discharged and then charged by the Recondition Battery selection 
under Actions.

• Reconditioning Needed. Battery has not been reconditioned within 30 
discharge/charge cycles. Select “Recondition Battery” under Actions, 
then click Apply.

• Reconditioning Active. Process of discharging/recharging the battery 
is underway. Allow the process to complete or it will have to be 
repeated. If you do need to interrupt reconditioning, select “Stop 
Recondition” under Actions, then click Apply.

• Fast Charging Active. Battery is being charged. A fast charge also 
occurs when the controller is powered on.

• Discharging Active. Battery is currently discharging, which is the first 
stage of a Recondition Battery action.

Actions

The Actions area of the Intelligent Battery Backup Unit dialog box contains 
the following:

• Set Low Power Threshold. Edit the Low Power Threshold field under 
Power Levels. To change the threshold to this new setting, select Set 
Low Power Threshold, then click Apply.

• Recondition Battery. To initiate a battery recondition sequence, select 
Recondition Battery, then click Apply. The controller cache is placed in 
conservative cache mode (Write Through) while the battery’s capacity 
remains below the determined threshold.
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• Discharge Battery. Currently inactive. Reserved for future use.

• Fast Charge. To initiate a fast charge on the battery, select Fast 
Charge, then click Apply. A fast charge also occurs when the controller 
is powered on.

• Stop Recondition. Only enabled when a recondition process is 
underway. To stop the recondition process, select Stop Recondition, 
then click Apply.

• Apply. Applies and saves the changes made in the BBU dialog box.

• Cancel. Exits the dialog box but does not stop the current action.

Conditioning the Battery

A full battery condition cycle consists of discharging and recharging the 
battery. The condition cycle must start with a fully charged battery. Normally 
the battery is automatically recharged, but in a new system or a system that 
has been subjected to a power outage, recharging may be necessary and may 
take several hours.

☛ Note
Do not interrupt the reconditioning process.

The system administrator must initiate the condition cycle manually. The 
condition cycle must complete without an interruption of power. In addition, 
the operator must not interrupt the cycle by initiating a fast charge or another 
condition cycle. If the cycle is interrupted for any reason, the batteries must 
be recharged and the recondition process must be restarted.

☛ Note
During the reconditioning, write back cache mode 
will be disabled. This may slow normal operations. 
Therefore, schedule this operation accordingly.

To ensure that the battery is fully charged and properly conditioned:

1. Choose Intelligent BBU from the Administration menu if the BBU 
dialog box is not currently displayed.

2. Make sure the “% Charge Level” is 100. If the battery is currently 
charging, Do Not continue until the Charge Level is 100.

3. Under Actions, select Recondition Battery, then click Apply.
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Chapter 6
Maintenance Processessses
Introduction
Maintenance processes include the following activities which you may need 
to perform from time to time on arrays that use redundancy and/or fault 
tolerance, or to maintain the most up-to-date firmware maintenance releases:

• Running a logical drive initialization.

• Running a consistency check on a logical drive to examine (and 
optionally restore) consistency (parity). Encountered errors will be 
written to the Error Table.

• Running a data rebuild on a physical drive that replaces a drive that 
went dead or offline.

• Upgrading Mylex PCI Controller firmware, BIOS, boot block, or BIOS 
Configuration Utility.

• Defragmenting an Array.

• Clearing a configuration.
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Running a Logical Drive Initialization
Logical drive initialization offers the ability to run a full initialization of 
logical drives at a time of your choice, not just immediately following a new 
configuration. If it’s inconvenient to follow a configuration immediately 
with a logical drive initialization, you can decline the initialization and use 
this menu item to start the process at a later time. 

To open Initialize Logical Drives click Administration->Initialize Logical 
Drives on the menu bar as shown in Figure 6-1.

Figure 6-1. Select “Initialize Logical Drives”

An Initialize Logical Drives dialog box opens (Figure 6-2).

Figure 6-2. Initialize Logical Drives Dialog Box
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To select logical drives to initialize, check the desired checkboxes next to the 
appropriate logical drive. Click The OK button or press the Enter key to 
begin the initialization. A Warning message dialog box will open for 
confirmation.

Figure 6-3. Initialization Confirmation Dialog Box

Type YES to confirm the initialization and click the OK button or press the 
Enter key. The Initialize Status Dialog box opens (Figure 6-4).

Figure 6-4. Initialize Status Dialog Box

This dialog box is used to monitor and/or cancel initialization. See “Process 
Status Monitoring” on page 5-22 for more information.
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Running a Logical Drive Consistency Check
From time to time run a consistency check on each of your fault tolerant 
logical drives. This check scans the logical drive to determine whether 
consistency data has become corrupted and needs to be restored. If you have 
reason to believe that logical drive consistency data is corrupted, or if you 
wish to run a consistency check for maintenance reasons, perform the 
following procedure:

1. Double-click a logical drive in Controller View (right side of a 
Controller View window).

2. Click the Consistency Check button in the Logical Drive Information 
dialog box to begin.

A message is displayed asking if you would like consistency to be restored 
in the event of errors (Figure 6-5):

Figure 6-5. Restore Consistency If Errors Are Found?

3. Click Yes to restore consistency during the process.

� Caution
If consistency data is badly corrupted on a logical 
drive, attempting to restore consistency may result in 
corrupted real data. Use the Yes option with caution.

Click No if you just want to carry out the consistency check. There is 
no risk of data loss. Errors will still be reported to the Error Table but 
no attempt will be made to correct them.

Consistency Check runs and the Consistency Check Status box appears (see 
the previous chapter). Close the box and continue or leave the box open until 
Consistency Check has completed.
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Running a Device Rebuild
If a single device in a fault tolerant system fails, the system is spared data 
loss by virtue of the striping with parity present across the logical drive 
(RAID 3, RAID 5) or the total redundancy of data (RAID 1, RAID 0+1). 
The failed drive needs to be replaced, and the failed drive’s data must be 
rebuilt on a new drive to restore the system to fault tolerance once again.

The device rebuild function performs this task. A failed drive’s data can be 
rebuilt to:

• The original drive if this drive happens to be still functional,
• A hot spare (standby) drive present for just this purpose, or
• A drive inserted in place of the failed drive.

If you need to carry out a device rebuild, perform the following procedure:

1. Reinsert the removed drive that caused the failure (if it is still a good 
drive), or replace the failed drive with a new drive of equal or greater 
capacity.

2. Double-click the relevant physical device in the Controller View 
window.

The Disk Device Information dialog box will open, and the Rebuild 
button should be available (Figure 6-6).

Figure 6-6. Rebuild Button Available for This Disk Device
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3. Click the Rebuild button in the Disk Device Information dialog box.

Rebuild runs and the Rebuild Status box appears (see the previous chapter). 
Close the box and continue or leave the box open until Rebuild has 
completed.

When rebuild has completed, the selected physical device AND the logical 
drive(s) of which it is a part are returned to operational status. If you cancel 
rebuild, the device returns to its offline (dead) status (red X), and the logical 
drives that occupy this physical device all go to critical status (yellow 
exclamation point). You must complete a future rebuild to return the 
physical device and logical drive(s) to operational status.
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Using the Flash Utility
The Flash Utility is used to upgrade firmware, BIOS, boot block, and BIOS 
Configuration Utility software by “flashing” the new code stored in an 
identified .IMG file to the on-board BIOS of the Mylex PCI Disk Array 
Controller. As maintenance releases of this code become available, this 
utility allows you to keep your controller current using GAM.

� Caution
If Expand Array (Expand Capacity) is running or was 
stopped, you must allow the process to run to 
completion BEFORE replacing controllers and 
flashing new firmware. Otherwise, data corruption 
may result!

Open the Flash Utility as shown in Figure 6-7:

Figure 6-7. Select “Flash Utility”
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The Flash Utility dialog box appears as shown in Figure 6-8:

Figure 6-8. Flash Utility Dialog Box

Under Current RAM Information, you see displayed the key information 
regarding the code that is currently stored in the BIOS of your selected 
controller. This information is helpful for diagnostic and troubleshooting 
purposes as well as to determine whether you need to upgrade some aspect 
of the firmware, BIOS, etc.

To perform a flash upgrade:

1. Type the name of the appropriate image file (.IMG) in the Flash file 
selection box, or click the Browse button to locate the file.

If you select Browse, the Open Image file dialog box is displayed as 
shown in Figure 6-9:
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Figure 6-9. Open Image File Dialog Box

2. Select the image filename using the file selection dialog box.

3. Click Open.

Once you’ve specified an appropriate image file, the Start Flash button 
becomes available in the Flash Utility dialog box, and the Flash file 
selection area displays details regarding the .IMG file (Figure 6-10).

Figure 6-10. Additional Flash File Information
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4. Compare the information for the new .IMG with the current 
information to confirm that a flash is warranted (for example, that the 
.IMG contains a newer version of code).

5. Click Start Flash.

Because flashing new code to the controller erases what was there 
previously, two levels of confirmation are required to proceed with the flash.

6. Click OK at the first confirmation message.

7. Type YES, then click OK at the second confirmation message.

The controller will be updated with the new code contained in the .IMG 
file.
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Defragmenting an Array
Randomly deleting a logical drive(s) will result in unused spaces in an array. 
Use this feature to unify space. You will need the following information 
before beginning a defragmentation:

• The location of unused space for the creation of a new logical drive.

• Capacity expansion through MORE2 with an unused physical 
disk(s).

• A transportation model or other logical drives in the array where the 
new logical drive is to be created.

To defragment an array:

1. Select Administration->RAID Assist on the menu bar or the RAID 
Assist icon (see Figure 4-7).

2. Click the Manual Configuration button.

3. Click the Defragment Array button, and a Manual Configuration/
Defragment Array Window opens.

Figure 6-11. Manual Configuration/Defragment Array

This window displays all arrays under the selected controller. The array 
at the top of the list is selected by default. If the selected array has two 
or more unused spaces, the Apply button becomes enabled.

The Logical Drives in the selected array pane shows the RAID level 
and size of the logical drives.
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The Array Space pane shows the following information:

• unused disk space

• total number of unused space (MB) in the array

• the largest unused space (MB) in the array

Click the Apply button to begin defragmenting. A warning message 
box opens (Figure 6-12):

Figure 6-12. Defragmentation Warning Message

4. To confirm your decision to defragment, type YES then click OK, or 
click Cancel to stop.

5. The Status of the defragmentation can be monitored on the Expand 
Capacity Status Window, see “Expand Capacity Status” on page 5-25.
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Clearing a Configuration
Use the following procedure to clear a configuration.

1. Open the Clear Configuration dialog box, select File>Clear 
Configuration.

The Clear Configuration Dialog box opens (see Figure 6-13).

Figure 6-13. Clear Configuration Dialog Box

2. Select the disk array(s) that you want to delete. 

3. Click OK to clear the configuration. A caution message box will open 
(see Figure 6-14).

Figure 6-14. Clear Configuration Caution Message 

4. Click the Yes button to continue.

A warning message box will open (see Figure 6-15).
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Figure 6-15. Clear Configuration Warning Message

5. To confirm your decision to clear the selected configuration, type YES 
then click OK, or click Cancel to stop.
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Appendix A
Event Information
Overvieww
Global Array Manager provides information about drive and controller 
failures, as well as maintaining an event log. Global Array Manager 
classifies the events it records into five severity levels described in 
Table A-1. All event information can also be found in the text file 
EventDef.txt in the GAMFiles folder of the GAM directory.

Table A-1. Severity Level Priorities and Descriptions

Severity Type Description

0 Critical Controller failure.

1 Serious The failure of a major component within the array 
enclosure. For example, a power supply, fan or 
physical drive.

2 Error A consistency check fails, or a rebuild on a drive 
stopped because of errors.

3 Warning Global Array Manager has failed to kill a drive, or 
failed to start a rebuild.

4 Informational Messages such as sign-ons and system 
startups. When a consistency check or a rebuild 
has finished, for example, or a physical drive has 
been put on standby.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions

1 4 A physical disk has 
been placed online.

Rebuild completed. 
Physical disk was 
configured. Manual 
on-line was done.

None.
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2 4 A physical disk has 
been added as hot 
spare.

Device was 
configured. Manual 
hot spare was done. 
Automatic hot spare 
was done. 'Raidbld' 
made it hot spare.

None

5 4 An automatic 
rebuild has started.

A physical device 
failed and spare was 
available. A physical 
device failed and no 
spare was available. 
A spare was added.

None.

6 4 A rebuild has 
started.

Client started the 
rebuild on user's 
request. User 
replacd the failed 
device and 'raidbld' 
started the rebuild.

None.

7 4 Rebuild is over. Rebuild completed 
successfully.

None.

8 3 Rebuild is 
cancelled.

User cancelled the 
rebuild. Higher 
priority rebuild 
started.

Restart the 
rebuild if 
required.

9 2 Rebuild stopped 
with error.

Due to some 
unknown error on the 
controller, rebuild 
failed.

Try rebuild 
again.

10 2 Rebuild stopped 
with error. New 
physical disk failed.

New physical device 
failed. New physical 
device may not be 
compatible with 
MDAC hardware/
firmware.

Replace the 
physical disk.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
A-2 GAM Client User’s Guide



Event Information
11 2 Rebuild stopped 
because logical 
drive failed.

At least one more 
physical device failed 
in the array. Bad data 
table overflow.

It may not be 
possible to 
recover from this 
error. Contact 
your service 
representative.

12 1 A physical disk has 
failed.

A physical disk failed. 
A user action caused 
the physical disk to 
fail.

Replace the 
physical disk.

13 4 A new physical disk 
has been found.

A physical disk has 
been powered on. A 
new physical disk 
has been added. 
Controller was 
powered on. 
Controller was 
added. System has 
rebooted.

None.

14 4 A physical disk has 
been removed

User removed an 
unconfigured 
physical disk. An 
unconfigured 
physical disk failed. A 
controller was 
removed. A controller 
powered off.

Replace the 
device if needed.

15 4 A previously 
configured physical 
disk is now 
available.

User set the physical 
device to 
unconfigured.

None.

16 4 Expand Capacity 
Started.

User started the 
RAID Expansion 
operation. A 
suspended RAID 
Expansion operation 
was started.

None.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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17 4 Expand Capacity 
Completed

RAID Expansion 
finished.

None.

18 2 Expand Capacity 
Stopped with error.

Multiple physical 
devices failed.

It may not be 
possible to 
recover from this 
error. Contact 
your service 
representative.

19 3 SCSI command 
timeout on physical 
device.

Physical device has 
been removed. 
Physical device 
failed. Command 
time out value is not 
correct.

Refer to the 
enclosure 
manufacturer’s 
service manual.

20 0 SCSI command 
abort on physical 
disk.

User may have 
requested to abort 
the command. 
Firmware may have 
aborted the 
command to recover 
from error. The 
device may have 
aborted the 
command.

None.

21 3 SCSI command 
retried on physical 
disk.

The command may 
have timed out. Bus 
reset may have 
occured. Device 
reset may have 
occured.

None.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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22 3 Parity error found. A physical device did 
not generate proper 
parity. The controller 
failed, did not check 
parity properly. Cable 
failed. Improper 
cable length. Another 
physical device 
interfered. Some 
outside environment 
affected the data on 
the cable (eg.radio 
frequency signal). 
Terminator is not 
connected. Improper 
termination.

It may not be 
possible to 
recover from this 
error. Refer to 
the enclosure 
manufacturer’s 
service manual.

23 3 Soft error found. An error was 
detected by physical 
device and data was 
recovered.

Run consistency 
check. If problem 
occurs 
frequently, 
replace the 
physical device.

24 3 Misc error found. A physical device 
reported some error 
which does not fit in 
any category. Read/
Write command time 
out. Data over run. 
Physical device was 
busy when host 
attempted to send 
command.

If problem 
occurs 
frequently, 
replace the 
physical device.

25 4 SCSI device reset. Firmware has done 
reset to recover from 
error. User has done 
a reset.

None.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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26 4 Active spare found. Device was 
configured. Manual 
active spare was 
done. Automatic 
active spare was 
done.

None.

27 4 Warm spare found. Device was 
configured. Manual 
warm spare was 
done. Automatic 
warm spare was 
done.

None.

28 2 Request Sense 
Data available.

A physical device 
reported an error. 
Firmware reported 
an operational error.

Read the 
request sense 
data to 
understand the 
root cause.

29 4 Initialization started. Host started the 
initialization.

Wait till the 
initialization is 
completed. If the 
system is 
shutdown prior 
to this process 
being completed 
the physical 
device can be 
made useful only 
by reinitializing it.

30 4 Initialization 
completed.

Physical device 
initialization 
completed 
successfully.

None

31 3 Initialization failed. Physical device 
could have some 
problems with 
supporting the SCSI 
format command.

Try to initialize 
again. Contact 
your service 
representative.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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32 1 Initialization 
cancelled.

User cancelled the 
operation.

Physical disk 
must be 
initialized again 
or the Physical 
disk cannot be 
used.

33 1 A physical disk 
failed because write 
recovery failed.

Write recovery 
process failed.

Replace physical 
disk and rebuild 
it.

34 1 A physical disk 
failed because 
SCSI bus reset 
failed.

SCSI bus reset 
failed.

Replace physical 
disk and rebuild 
it.

35 1 A physical disk 
failed because 
double check 
condition occured.

Double check 
condition occurred.

Replace physical 
disk and rebuild 
it.

36 1 A physical disk 
failed because 
device is missing.

Access to the 
physical disk failed.

Replace physical 
disk and rebuild 
it.

37 1 A physical disk 
failed because of 
gross error on SCSI 
processor.

Gross error occurred 
to the on board SCSI 
processor.

Replace physical 
disk and rebuild 
it.

38 1 A physical disk 
failed because of 
bad tag from the 
device.

The device 
responded with an 
invalid tag.

Replace physical 
disk and rebuild 
it.

39 1 A physical disk 
failed because 
command to the 
device timed out.

SCSI command 
timed out on the 
device.

Replace physical 
disk and rebuild 
it.

40 1 A physical disk 
failed because of 
the system reset.

System reset 
occured.

Replace physical 
disk and rebuild 
it.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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41 1 A physical disk 
failed because of 
busy status or parity 
error.

The device returned 
busy status. The 
SCSI transaction 
with the device met 
with parity error.

Replace physical 
disk and rebuild 
it.

42 1 A physical disk set 
to failed state by 
host.

Command from host 
set the Physical disk 
to failed state.

Replace physical 
disk and rebuild 
it.

43 1 A physical disk 
failed because 
access to the 
device met with a 
selection time out.

Device disconnected 
or powered off. Bad 
device.

Replace physical 
disk and rebuild 
it. Check power 
and cabling.

44 1 A physical disk 
failed because of a 
sequence error in 
the SCSI bus phase 
handling.

Physical disk failure. Replace physical 
disk and rebuild 
it.

45 1 A Physical disk 
failed because 
device returned an 
unknown status.

Bad Physical disk or 
incompatible device.

Replace 
Physical disk or 
the device and 
rebuild it.

46 1 A Physical disk 
failed because 
device is not ready.

Device not spinning, 
just turned bad. 
Power to the device 
failed.

Replace 
Physical disk 
and rebuild it. 
Check power 
and rebuild 
device.

47 1 A Physical disk 
failed because 
device was not 
found on start up.

Device not 
connected. Device 
not responding. 
Clear configuration 
suspend mode 
command was 
invoked.

Check setup. 
Check the 
startup option 
parameters on 
the system.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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48 1 A Physical disk 
failed because write 
operation of the 
'Configuration On 
Disk' failed.

Bad Physical disk. 
Device write 
protected.

Replace 
Physical disk 
and rebuild it. 
Check the 
startup option 
parameters on 
the system.

49 1 A Physical disk 
failed because write 
operation of 'Bad 
Data Table' failed.

Bad Physical disk. 
Device write 
protected.

Replace 
Physical disk 
and rebuild it. 
Check the 
startup option 
parameters on 
the system.

57 1 Physical disk 
missing on startup.

Physical disk 
missing.

Replace the 
Physical disk or 
power-on all 
enclosures.

58 3 Rebuild startup 
failed due to lower 
disk capacity.

Device capacity not 
sufficient for doing 
rebuild.

Replace with a 
disk having 
sufficient 
capacity.

59 3 Physical disk is 
switching from a 
channel to the other 
channel.

Physical disk 
removed or channel 
failed

Check FC loop; 
replace physical 
disk if 
necessary. 

60 2 Temporary-Dead 
physical drive is 
automatically made 
online.

Temporary-Dead 
state caused 
because of transient 
errors

Analyze event 
log to find out 
why the drive 
was marked 
DEAD.

61 4 A standby rebuild 
has started.

A physical device 
failed and spare was 
available.

None.

Table A-2. GAM Events for PCI Controllers

ID Severity Description Details Actions
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62 4 Hot spare replaced 
with a smaller 
capacity physical 
disk.

The new hot spare 
may have a smaller 
physical capacity 
than the physical disk 
it replaced.
The controller's 
coercion setting may 
have reduced the 
configurable size of 
the new hot spare.

None.

63 3 A storage access 
path has come 
online.

PathPilot reported an 
access path has 
become available.
Storage previously 
unavailable has 
become available 
again.

None. This 
indicates that 
storage access 
has been 
restored. 

64 3 A storage access 
path has been lost.

PathPilot is unable to 
access certain 
storage on any path.
Storage previously 
available is now 
unavailable.

Investigate 
possible causes; 
e.g., cabling, 
controller or HBA 
failure. 

65 3 A storage access 
path has shifted to 
the alternate path.

PathPilot is unable to 
access storage on 
the original path but 
is able to use the 
alternate path.
A PathPilot failover 
has occurred.

Investigate 
possible causes; 
e.g., cabling, 
controller or HBA 
failure. 

66 0 A storage access 
path has shifted to 
the primary path.

PathPilot is again 
able to access 
certain storage on 
the original path.
A PathPilot failback 
has occurred.

None. This 
indicates that the 
primary path has 
been restored. 

Table A-2. GAM Events for PCI Controllers
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128 4 Consistency check 
is started.

User started a 
consistency check. 
Raidbld started 
consistency check.

None.

129 4 Consistency check 
is finished.

Consistency check 
completed 
successfully without 
detecting any errors.

None.

130 3 Consistency check 
is cancelled.

User cancelled the 
consistency check.

Restart 
consistency 
check, if 
required.

131 2 Consistency check 
on logical drive 
error.

Inconsistent data 
was found. Bad 
sectors were found. 
A physical device 
reliability problem.

See bad block 
and request 
sense table for 
more 
information.

132 2 Consistency check 
on logical drive 
failed.

A logical device 
became critical. A 
logical device failed.

See request 
sense data for 
more 
information.

133 1 Consistency check 
failed due to 
physical disk failure.

A physical disk failed. See request 
sense data for 
more 
information.

134 1 Logical drive has 
been made offline.

One/multiple 
physical device(s) 
failed.

It may not be 
possible to 
recover from this 
error. Contact 
your service 
representative.

135 2 Logical drive is 
critical.

One physical device 
failed.

Replace the 
physical device. 
Start the rebuild, 
if required.

Table A-2. GAM Events for PCI Controllers
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136 4 Logical drive has 
been placed online.

Rebuild completed. 
User set the physical 
disk online. New 
configuration was 
added.

None.

137 4 An automatic 
rebuild has started 
on logical drive.

A physical disk failed 
and a spare device 
was available. A 
spare physical disk 
was found and 
replaced the failed 
device.

None.

138 4 A manual rebuild 
has started on 
logical drive.

Client started the 
rebuild on user's 
request. User 
replaced the failed 
device and 'Raidbld' 
started the rebuild.

None.

139 4 Rebuild on logical 
drive is over.

Rebuild completed 
successfully only for 
this logical drive.

None.

140 3 Rebuild on logical 
drive is cancelled.

User cancelled 
rebuild. Higher 
priority rebuild 
started.

Restart the 
rebuild if 
required.

141 2 Rebuild stopped 
with error.

Due to an unknown 
error on the controller 
rebuild failed.

Try rebuild 
again.

142 2 Rebuild stopped 
with error. New 
device failed.

New physical device 
failed. New physical 
device is not 
compatible with 
MDAC hardware/
firmware.

Replace the new 
device.

Table A-2. GAM Events for PCI Controllers
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143 2 Rebuild stopped 
because logical 
drive failed.

At least one more 
physical disks failed 
in the array.

It may not be 
possible to 
recover from this 
error. Contact 
your service 
representative.

144 4 Logical drive 
initialization started.

User started the 
initialization. Any 
previous data is lost.

None.

145 4 Logical drive 
initialization done.

Initialize operation 
completed 
successfully.

None.

146 3 Logical drive 
initialization 
cancelled.

User cancelled the 
initialization.

Restart 
initialization if 
required.

147 2 Logical drive 
initialization failed.

One/multiple 
physical device(s) 
failed. Controller has 
been removed. 
Controller has been 
powered off.

Refer to the 
device failure 
event.

148 4 A logical drive has 
been found.

A new configuration 
has been added. 
MORE completed. A 
new controller has 
been plugged in. 
Controller has been 
powered on. System 
has rebooted.

None.

149 4 A logical drive has 
been deleted.

A new configuration 
has been added. A 
new logical device 
has been deleted. 
Controller has been 
removed. Controller 
has been powered 
off.

None.

Table A-2. GAM Events for PCI Controllers
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Manual No. SA67-0049-01 A-13



Overview
150 4 Expand capacity 
started.

User started the 
Online RAID 
Expansion operation.

None.

151 4 Expand Capacity 
Completed.

Online RAID 
Expansion 
completed.

None.

152 2 Expand Capacity 
stopped with error.

Multiple physical 
disks failed.

It may not be 
possible to 
recover from this 
error. Contact 
your service 
representative.

153 0 Bad Blocks found Bad sector was 
found on a physical 
disk during : 
consistency check/
rebuild/RAID 
Expansion operation.

Run a 
Consistency 
Check with the 
Restore option. 
Restore data 
from a back up.

154 4 System drive size 
changed.

A new configuration 
has been added. 
RAID Expansion has 
added extra capacity.

None.

155 4 System drive type 
changed.

A new configuration 
has been added. 
RAID migration 
completed. RAID 
Expansion 
completed on RAID 
1.

None.

156 1 Bad data blocks 
found. Possible 
data loss.

Bad blocks were 
found on multiple 
physical devices in 
same zone.

Restore data 
from a back up.
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158 1 Attempt to read 
data from block that 
is marked in Bad 
Data Table.

Attempt to read from 
block that is already 
marked bad in Bad 
Data Table. Potential 
data loss.

Restore data 
from a back up.

159 2 Data for Disk Block 
has been lost due to 
Logical Drive 
problem.

Data retained in 
RAID Cache for a 
Write-back Logical 
Drive cannot be 
stored to the physical 
medium because of 
Logical Drive 
problem. The Logical 
Drive problem could 
be because of 
multiple physical 
medium error or 
multiple physical 
devices offline or 
other reasons.

Insure that all the 
Physical Drives 
related to the 
Logical Drive, 
disk channel, 
enclosure or 
cabling are 
functional and 
accessible. 
Repair or 
replace them if 
necessary.

160 2 Temporary-Offline 
RAID5/RAID3 array 
is available to the 
user again with the 
possibility of data 
loss in the array.

Temporary-Offline 
state caused 
because of transient 
errors in physical 
drives.

Verify data from 
backup.

161 2 Temporary-Offline 
RAID0+1/RAID1/
RAID0/JBOD array 
is available to the 
user again.

Temporary-Offline 
state caused 
because of transient 
errors in physical 
drives.

No action.

162 4 An standby rebuild 
has started on 
logical drive.

A physical disk failed 
and a spare device 
was available.

None.

256 1 Fan Failure. Cable connection is 
broken. Fan failure.

Replace fan.
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182 2 Low battery charge 
level. Logical drive 
may have lost data.

Controller was 
powered off for 
duration longer than 
battery capacity. 
User connected a 
new controller. User 
connected a new 
BBU.

Run consistency 
check to verify 
logical drive 
consistency. If 
needed, restore 
data from 
backup.

257 4 Fan has been 
restored.

Faulty fan has been 
replaced. Cable is 
connected properly.

None.

258 2 Fan failure. Cable connection is 
broken. Fan failure.

Replace fan.

259 4 Storage cabinet fan 
is not present.

Enclosure 
Management 
Connection is 
broken. Management 
hardware failure. Fan 
is not present.

Refer to the 
enclosure 
manufacturer's 
service manual. 

272 1 Power supply 
failure.

Cable connection is 
broken. Power 
supply failure.

Reconnect cable 
or replace the 
power supply as 
required.

273 4 Power supply has 
been restored.

Faulty power supply 
has been replaced.

None.

274 2 Power supply 
failure.

Cable connection 
broken. Power 
supply failure.

Replace power 
supply.

275 4 Storage cabinet 
power supply is not 
present.

Management 
connection is broken. 
Management 
hardware failure. 
Power supply is not 
present.

Refer to the 
enclosure 
manufacturer's 
service manual. 
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288 2 Over temperature. 
Temperature is 
above 70 degrees 
Celsius.

Room temperature is 
too high. Bad fan. 
Bad sensor.

Turn off the 
system and 
allow it to cool 
down. Adjust the 
room 
temperature.

289 3 Temperature is 
above 50 degrees 
Celsius.

Room temperature is 
high.
Fan failure.

Replace fan. 
Turn off the 
system. Adjust 
the room 
temperature.

290 4 Normal temperature 
has been restored.

Faulty fan has been 
replaced. Room 
temperature was 
reduced.

None.

291 2 Over temperature. Room temperature is 
too high. Fan failure.

Turn off the 
system and 
allow it to cool 
down. Adjust the 
room 
temperature.

292 4 Storage cabinet 
temperature sensor 
is not present.

Enclosure 
management 
connection is broken. 
Management 
hardware is bad. 
Sensor is not 
present.

Refer to the 
enclosure 
manufacturer's 
service manual. 

304 2 Storage Works 
enclosure reported 
failure state.

Power supply failed. 
Fan failed. Cabinet is 
too hot.

Follow enclosure 
management 
vendor's 
diagnostics and 
repair 
procedures.

305 3 Storage Works 
enclosure reported 
critical state.

Not available. Not available.
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306 4 Storage Works 
enclosure reported 
normal state.

Problem has been 
rectified.

None.

320 1 Fan failure. Cable connection 
broken. Fan failure.

Replace fan.

321 4 Fan has been 
restored.

Faulty fan has been 
replaced. Cable is 
connected properly.

None.

322 4 Fan is not present. Enclosure 
Management 
Connection is 
broken. Management 
hardware failure. Fan 
is not present.

Refer to the 
enclosure 
manufacturer's 
service manual. 

323 1 Power supply 
failure.

Cable connection is 
broken. Power 
supply failure.

Replace the 
power supply.

324 4 Power supply has 
been restored.

Faulty power supply 
has been replaced.

None.

325 4 Power supply is not 
present.

Management 
connection is broken. 
Management 
hardware is bad. 
Power supply is not 
present.

Refer to the 
enclosure 
manufacturer's 
service manual. 

326 2 Temperature is over 
safe limit. Failure 
imminent.

Room temperature is 
too high. Fan failure. 
Sensor failure.

Turn off the 
system and 
allow it to cool 
down. Adjust the 
room 
temperature.

327 3 Temperature is 
above working limit.

Room temperature is 
too high. Fan failure.

Turn off the 
system. Adjust 
the room 
temperature. 
Replace fan.
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328 4 Normal temperature 
has been restored.

Faulty fan has been 
replaced. Room 
temperature was 
reduced.

None.

329 4 Temperature 
sensor is not 
present.

Enclosure 
management 
connection is broken. 
Management 
hardware failure. 
Sensor is not 
present.

Refer to the 
enclosure 
manufacturer's 
service manual. 

330 3 Enclosure access 
critical.

Enclosure 
management 
connection is broken. 
Management 
hardware failure.

Refer to the 
enclosure 
manufacturer's 
service manual. 

331 4 Enclosure access 
has been restored.

Enclosure has been 
fixed or replaced.

None.

332 2 Enclosure access is 
offline.

Enclosure 
management 
connection is broken. 
Management 
hardware failure.

Refer to the 
enclosure 
manufacturer's 
service manual. 

384 4 Array management 
server software 
started 
successfully.

The server system 
(or array 
management utility 
server) started.

If you did not 
expect a system 
reboot, 
investigate.

385 2 Write back error. Data cache write 
failed.

The data may 
have been lost. 
Restore the data 
from a backup.
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386 3 Internal log 
structures getting 
full, PLEASE 
SHUTDOWN AND 
RESET THE 
SYSTEM IN THE 
NEAR FUTURE.

Too many 
configuration 
changes occurred 
since the last boot.

Reboot the 
system by power 
cycling when 
ever convenient.

388 0 Controller is dead. 
System is 
disconnecting from 
this controller.

Hardware failure. Contact your 
service 
representative.

389 3 Controller has been 
reset.

Controller received a 
reset command.

If this was an 
unexpected 
event, refer to 
the enclosure 
manufacturer's 
service manual. 

390 4 Controller is found. New controller has 
been installed.
Management 
software has 
restarted.
System has 
rebooted.

None.

391 0 Controller is gone. 
System is 
disconnecting from 
this controller.

Controller has been 
powered off or has 
been reset.
Controller has been 
removed from the 
system.

None.

392 4 Battery Present A battery module has 
been detected and is 
now operational.

None.
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393 3 Battery Power Low. Battery power is low. If this message 
occurs without 
power failure, 
replace the 
Battery.

394 4 Battery Power OK. Battery does not 
have enough power 
to enable the write 
data cache.

None.

395 0 Controller is gone. 
System is 
disconnecting from 
this controller.

The connection to 
the controller has 
been lost.

None.

396 4 Controller powered 
on.

Controller was 
removed from the 
system. Controller 
has been powered 
off.

None.

397 4 Controller is online. New controller has 
been installed.

None.

398 0 Controller is gone. 
System is 
disconnecting from 
this controller.

Controller was set 
online.

None.

399 3 Controller's partner 
is gone, controller is 
in failover mode 
now.

Controller was set 
offline.

If you did not 
expect this, 
investigate.

403 1 Installation aborted. Equipment 
improperly arranged 
while powered off.

Re-establish 
proper 
arrangement. 

404 1 Controller firmware 
mismatch.

Replacement 
controller with 
downlevel firmware 
installed.

Reload controller 
firmware.
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405 3 Battery Removed. Battery physically 
removed.

Reinstall the 
battery.

414 3 Soft ECC error 
Corrected.

Faulty Memory 
Module.

Replace Memory 
Module.

415 3 Physical ECC error 
Corrected.

Faulty Memory 
Module.

Replace Memory 
Module.

418 2 BBU out of service. BBU will not be able 
to power the cache if 
AC power fails. 
Firmware will switch 
WriteBack logical 
drives to 
WriteThrough.

Replace BBU.

427 2 Mirror Race 
recovery failed.

Some physical 
devices may have 
failed.

Run consistency 
check and 
restore 
consistency.

428 0 Mirror Race on 
critical logical drive. 

Logical device is 
critical.

Replace failed 
physical disk and 
rebuild.

429 4 Controller 
connected to 
cluster.

One or more 
controllers detected 
during scan and 
entered nexus with 
those controllers. 

None.

430 4 Controller 
disconnected from 
cluster. 

All other controllers 
in cluster are 
inaccessible due to 
controller powered 
off or controller 
failure or cable 
failure. 

If this was an 
unexpected 
event, refer to 
service manual 
and correct the 
failure.
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431 2 Controller 
improperly 
shutdown! Data 
may have been lost.

User improperly 
shutdown the 
controller that 
resulted in 
inconsistent logical 
drive and/or data 
loss. 

Run consistency 
check to verify 
logical drive 
consistency.
If needed, 
restore data from 
backup.

512 4 System started. The server system 
(or array 
management utility 
server) started.

If you did not 
expect a system 
reboot, 
investigate.

513 4 Size table full. Too much physical 
disk size information 
is defined.

Remove unused 
size information 
from this system.

514 4 User logged in. An array 
management utility 
user logged in on the 
server system.

Not available.

515 4 User logged out. An array 
management utility 
user logged out of 
the server system.

Not available.

516 4 Server alive. Reconnected to 
server. Server 
rebooted.

None.

517 2 Lost connection to 
server, or server is 
down.

Lost network 
connection to server. 
Server shutdown.

None.

640 3 Channel Failed. Cable disconnected. Plug in cable.

641 3 Channel Online. Cable reconnected. None.

896 2 Internal Controller is 
in the hung state.

Internal Controller is 
in the hung state.

Controller has to 
be powered off 
and on.
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897 2 Internal Controller 
hung.

Internal controller is 
in the hung state.

Controller has to 
be powered off 
and on.

912 2 Internal Controller 
i960 processor 
error.

Internal Controller 
has encountered 
i960 processor 
specific error.

Controller has to 
be powered off 
and on.

928 2 Internal Controller 
Strong-ARM 
processor error.

Internal Controller 
has encountered 
Strong-ARM 
processor specific 
error.

Controller has to 
be powered off 
and on.
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ANSI
American National Standards Institute, a standards organization that 
promotes and facilitates understanding among qualified members for the 
implementation of agreed upon code and signaling standards and 
conformity. ANSI represents the U.S. in the ISO (International Standards 
Organization).

Applet
Small application programs that are usually built into an operating system or 
a larger application program and designed to run from within another 
application. The built-in writing and drawing programs that come with 
Windows are sometimes called “applets.” Applications that run in a web 
browser are often Java-based applets. See also Java.

Application Program
A program designed to perform a specific function directly for the user, or 
for another application program. Examples of application programs include 
word processors, database programs, Web browsers, development tools, 
drawing, paint and image editing programs, and communication programs.

Array
Multiple disk drives configured to behave as a single, independent disk 
drive. See also Disk Array.

Asynchronous Data Transfer
Data transfer not synchronized to a set timing interval. Asynchronous 
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devices must wait for a signal from the receiving device after each byte of 
data. Compare with Synchronous Data Transfer.

Automatic Rebuild
Mylex controllers provide automatic rebuild capabilities in the event of a 
physical disk drive failure. The controller performs a rebuild operation 
automatically when a disk drive fails and both of the following conditions 
are true: 

A standby or hot spare disk drive of identical or larger size is found attached 
to the same controller; 

All system drives that are dependent on the failed disk drive are configured 
as a redundant array: RAID 1, RAID 3, RAID 5, or RAID 0+1. 

During the automatic rebuild process, system activity continues; however, 
system performance may degrade slightly.

Automatic Switchover
See Failover

Background Initialization
Where the initialization process of a disk array takes place in the 
background, allowing use of a disk array within seconds instead of several 
hours. Also known as Immediate RAID Availability.

Benchmarks
A set of conditions or criteria against which a product or system is measured. 
Computer trade magazine laboratories frequently test and compare several 
new computers or computer devices against the same set of application 
programs, user interactions, and contextual situations. The total context 
against which all products are measured and compared is referred to as the 
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benchmark. Programs can be specially designed to provide measurements 
for a particular operating system or application. 

Berkeley RAID Levels
A family of disk array protection and mapping techniques described by 
Garth Gibson, Randy Katz, and David Patterson in papers written while they 
were performing research into I/O systems at the University of California at 
Berkeley. There are six Berkeley RAID levels, usually referred to as RAID 
Level 0 through RAID Level 5. See also RAID Levels.

BIOS
Basic Input/Output System, software that determines what a computer can 
do without accessing programs. The BIOS contains all the code required to 
control the keyboard, screen, drives, serial communications, and other 
functions. Usually the BIOS is built into a ROM chip installed on the 
motherboard so that the BIOS will always be available and not affected by 
disk failure. Sometimes the BIOS is recorded on a flash memory chip.

BIOS Config Utility
BIOS-based Configuration Utility, a utility program sequence used, upon 
powerup, for configuring various hardware elements in a system.

Booting (or Bootstrapping)
Loading operating system code and other basic software from a disk or other 
storage device to help a computer start.

Cache
A temporary storage area for frequently accessed or recently accessed data. 
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Cache is used to speed up data transfer to and from a disk. See also Caching.

Cache FlushFlush
Refers to an operation where all unwritten blocks in a Write-Back Cache are 
written to the target disk. This operation is necessary before powering down 
the system.

Cache Line Size
Represents the size of the data “chunk” that will be read or written at one 
time, and is set in conjunction with stripe size. Under RAID EzAssistTM, the 
cache line size (also known as Segment Size) should be based on the stripe 
size you selected. The default segment size for Mylex RAID controllers is 
8K. See also Stripe Size.

Caching
Allows data to be stored in a pre-designated area of a disk or RAM. Caching 
speeds up the operation of RAID systems, disk drives, computers and 
servers, or other peripheral devices. See also Cache.

Conservative Cache
An operating mode in which system drives configured with the Write-Back 
Caching policy are treated as though they were configured for Write-
Through operation and the cache is flushed.

Consistency Check
A process that verifies the integrity of redundant data. A consistency check 
on a RAID 1 or RAID 0+1 configuration (mirroring) checks if the data on 
drives and their mirrored pair are exactly the same. For RAID Level 3 or 
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RAID Level 5, a consistency check calculates the parity from the data 
written on the disk and compares it to the written parity. A consistency check 
from Mylex utilities such as Global Array ManagerTM (GAM) or RAID 
EzAssistTM give the user the ability to have a discrepancy reported and 
corrected. See also Parity Check.

Critical State
A Logical Drive is in a “critical” state if it has been configured at RAID 
level 1, 3, 5, or 0+1, and one (and only one) of its SCSI drives is not 
“online.” A logical drive is considered “critical” because any failure of 
another of its SCSI drives may result in a loss of data. 

Note: I/O operation can only be performed with system drives that are online 
or critical.

Cyclical Redundancy Check (CRC)
An error detection tool found on Ultra 160 SCSI (Ultra3 SCSI). This tool 
increases the odds for error free data.

DACCF
Disk Array Controller Configuration File (utility), a diskette-based 
configuration utility for RAID configuration.

Data Transfer Rate
The amount of data per unit of time moved through a channel or I/O bus in 
the course of execution of an I/O load, usually expressed in MBps.
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Degraded Mode
A RAID mode used when a component drive has failed.

Device Driver
A software program that controls a particular type of device attached to a 
computer, such as a RAID subsystem, printer, display, CD-ROM, disk drive, 
etc.

Disk Failure Detection
A RAID controller automatically detects SCSI disk failures. A monitoring 
process running on the controller checks, among other things, elapsed time 
on all commands issued to disks. A time-out causes the disk to be “reset” 
and the command to be retried. If the command times out again, the 
controller could take the disk “offline.” Mylex DAC960 controllers also 
monitor SCSI bus parity errors and other potential problems. Any disk with 
too many errors will also be taken “offline.” See also Offline.

Disk Media Error Management
Mylex controllers transparently manage disk media errors. Disks are 
programmed to report errors, even ECC-recoverable errors. If ECC RAM is 
installed, the controller will correct ECC errors. When a disk reports a media 
error during a read, the controller reads the data from the mirror (RAID 1 or 
0+1), or computes the data from the other blocks (RAID 3, RAID 5), and 
writes the data back to the disk that encountered the error. When a disk 
reports a media error during a write, the controller issues a “reassign” 
command to the disk, then writes the data out to a new location on the disk. 
Since the problem has been resolved, no error is reported to the system. 
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Drive Groups, Drive Packs
A group of individual disk drives (preferably identical) that are logically tied 
to each other and are addressed as a single unit. In some cases this may be 
called a drive “pack” when referring to just the physical devices. 

All the physical devices in a drive group should have the same size; 
otherwise, each of the disks in the group will effectively have the capacity of 
the smallest member. The total size of the drive group will be the size of the 
smallest disk in the group multiplied by the number of disks in the group. 
For example, if you have 4 disks of 400MB each and 1 disk of 200MB in a 
pack, the effective capacity available for use is only 1000MB (5x200), not 
1800MB.

Drivers
A software routine that receives I/O requests from higher levels within the 
operating system and converts those requests to the protocol required by a 
specific hardware device.

ECC
Error Correcting Code, a method of generating redundant information which 
can be used to detect and correct errors in stored or transmitted data.

EEPROM
Electrically Erasable PROM, see EPROM.

EPROM
Erasable Programmable Read Only Memory, memory which can be erased 
and re-used.
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eXtremeRAID™   ID™   
A family of Mylex RAID controllers which offer uncompromising fault 
tolerance, data availability, superior configuration, and management 
flexibility. The eXtremeRAID controllers use driver technology, which has 
won tpm-C benchmarks worldwide. With this technology, eXtremeRAID 
controllers provide the highest performance and most flexible RAID 
solution available today.

FAT, FAT 32
File Allocation Table, a distribution table maintained by an operating system 
on a hard disk that provides a map of the clusters (the basic unit of logical 
storage on a hard disk) that a file has been stored in. FAT 32 supports 32-bit 
processors.

Fault Tolerance, Failure Tolerance
The ability of a system to continue to perform its function even when one of 
its components has failed. A fault tolerant system requires redundancy in 
disk drives, power supplies, adapters, controllers, and cabling. Mylex RAID 
controllers offer high levels of fault tolerance.

Flash ROM
Memory on an adapter containing software that can be reprogrammed 
without removing it from the board.

Format
A pre-established layout for data. Programs accept data as input in a certain 
format, process it, and provide it as output in the same or another format. All 
data is stored in some format with the expectation that it will be processed by 
a program that knows how to handle that format. 
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Gigabit

109 (1,000,000,000) bits. Abbreviated as Gb. 

Gigabyte

230 (1,073,741,824) bytes. Abbreviated as G or GB.

Global Array Manager (GAM)™
A Mylex RAID management utility that allows a system administrator to 
configure, monitor, and manage network RAID storage from anywhere in 
the world. GAM can communicate critical information via e-mail, fax, 
pager, SNMP, or the launching of an application. GAM is everything needed 
to manage Mylex PCI RAID Controllers, SCSI Host Adapters, and External 
RAID Controllers.

GUI
Graphical User Interface, a software interface that interacts with the user 
through color graphics and a mouse.

Immediate RAID Availability
See Background Initialization

Interface
A hardware or software protocol that manages the exchange of data between 
the hard disk drive and the computer. The most common interfaces for small 
computer systems are ATA (advanced technology attachments), also known 
Manual No. SA67-0049-01 Glossary-9



Glossary
as IDE (integrated drive electronics), and SCSI.

Internet
A worldwide system of computers that is a public, cooperative, and self-
sustaining facility accessible to tens of millions of users worldwide.

Intranet
A network contained within an enterprise, the main purpose of which is 
usually to share company information and computing resources among 
employees. An intranet can also be used to facilitate working in groups and 
for teleconferences. 

I/O
Input/Output, the transmission of information between an external source 
and the computer.

I/O Intensive
An application whose performance depends strongly on the performance of 
the I/O system.

I/Os Per Second
Number of I/O transactions per second.

I2O

Intelligent Input/Output, a driver that uses special I/O processes to eliminate 
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I/O bottlenecks. The processes deal with interrupt handling, buffering, and 
data transfer. An I2O driver also includes an OS-specific module (OSM), 
which handles higher-level OS details, and a hardware device module 
(HDM), which knows how to communicate with certain devices.

ISM
Integrated Software Module, part of the I2O package that helps operators 
insert special functions into the I2O.

Java
A programming language expressly designed for use in the distributed 
environment of the Internet and enforces a completely object-oriented view 
of programming. Java can be used to create complete application programs 
that may run on a single computer or be distributed among servers and 
clients in a network. It can also be used to build small application modules, 
or applets, for use as part of a Web page. 

Kilobyte

210 (1,024). Abbreviated as K or KB.

LAN
Local Area Network, a network of interconnected workstations sharing the 
resources of a single processor or server, typically within the area of a small 
office building.

Latency
1. The time between the making of an I/O request and completion of the 
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request’s execution. 2. Short for rotational latency, the time between the 
completion of a seek and the instant of arrival of the first block of data to be 
transferred at the disk’s read/write head.

Logical Drive
The logical devices presented to the operating system. System drives are 
presented as available disk drives, each with a capacity specified by the 
Mylex RAID controller. See also Storage Device.

Logical Drive States
A logical (system) drive can be Online, Critical, or Offline. Notice that the 
term “online” is used for both physical and logical drives. 

LUN
Logical Unit Number, a SCSI representation of a system drive on a given 
channel and target ID. This may be a single device or an array of devices 
configured to behave as a single device.

LUN Mapping
A method whereby a LUN ID is assigned to a system drive, allowing a LUN 
to be made accessible through specific controllers and ports using system 
drive affinity.

LVD
Low Voltage Differential, a form of SCSI signaling introduced with Ultra2 
SCSI (Fast 40 SCSI). LVD uses data high and data low signal lines to 
increase transmission distances over those of single-ended (conventional 
SCSI signaling) lines. LVD allows for cable lengths of up to 12 meters 
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(approximately 39 feet) with up to 15 drives. LVD also lowers noise, power 
usage, and amplitude. 

LVD differs from conventional differential signaling in that only positive 
and negative values are distinguished, not voltage levels. Other advantages 
are that LVD devices consume less power and can sense single-ended 
devices on the bus and revert to single-ended signaling. Devices need to be 
Ultra2 SCSI LVD drives in order to take advantage of the LVD signaling. 
Mylex AcceleRAID, eXtremeRAID, and DAC FL controllers are LVD 
controllers.

Megabit
A million bits; used as a common unit of measure, relative to time in 
seconds, as an expression of a transmission technology's bandwidth or data 
transfer rates (abbreviated as Mb). Megabits per second (Mbps) is a frequent 
measure of bandwidth on a transmission medium.

Megabyte

220 (1,048,576) bytes. One megabyte can store more than one million 
characters. Abbreviated as M or MB.

Mirrored Cache
A cache memory that has duplicate data from another controller. In the event 
of failure of the original controller, the second controller can take the cached 
data and place it on the disk array.

Mirroring
The complete duplication of data on one disk drive to another disk drive, this 
duplication occurs simultaneously with each write operation: each disk will 
be the mirror image of the other (also known as RAID Level 1, see RAID 
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Levels). All Mylex RAID controllers support mirroring.

M.O.R.E.™   
Mylex Online RAID Expansion, an advanced configuration mode that 
allows expansion of any unconfigured or hot spare drive into the expandable 
drive group while the controller is online with the host. For example, a 
system using a five-disk-drive RAID set can add another disk drive to create 
a six-disk-drive RAID set. The M.O.R.E. operation can be performed on all 
RAID levels except JBOD. 

Mylex’s Global Array Manager (GAM) supports two M.O.R.E. features:

• Expand Capacity allows logical drive expansion for FFx external 
controllers only.

• Expand Array allows array expansion for both PCI and FFx external 
controllers.

During the RAID set expansion process, which includes re-striping data 
from the old (smaller) RAID set to the new (expanded) RAID set, the 
controller continues to service host I/O requests.

NFS
Network File System, a client/server application that lets a computer user 
view and optionally store and update files on a remote computer as though 
they were on the user's own computer. See also File Server.

NOS
Network Operating System, an operating system that has special features for 
connecting computers and peripheral devices into a LAN.
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NVRAM
Non-Volatile Random Access Memory, a memory unit equipped with a 
battery so that the data stays intact even after the main power had been 
switched off.

Offline 
A Logical Drive is in an “offline” state if no data can be read from it or 
written to it. Offline does not apply to physical disk drives. System 
commands issued to offline logical drives are returned with an error status; 
no operations can be performed on offline logical drives. See also Logical 
Drive States, Critical State, and Online

OLTP
Online Transaction Processing, computer processing where the computer 
responds immediately to user requests.

OS
Operating System, software that manages the system resources and provides 
the operating environment for application programs.

Parity
A method of providing complete data redundancy while requiring only a 
fraction of the storage capacity of mirroring. The data and parity blocks are 
divided between the disk drives in such a way that if any single disk drive is 
removed or fails, the data on it can be reconstructed using the data on the 
remaining disk drives. The parity data may exist on only one disk drive or be 
distributed between all disk drives in a RAID group. See also Rotated XOR 
Redundancy.
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Parity Check
A function used to verify the integrity of data on a system drive. It verifies 
that mirror or parity information matches the stored data on the redundant 
arrays. If the parity block information is inconsistent with the data blocks, 
the controller corrects the inconsistencies. See also Consistency Check. 

Partitioning
Where the full usable storage capacity of a disk or array of disks appears to 
an operating environment in the form of several virtual disks whose entire 
capacity approximates that of the underlying disk or array. 

Physical Device
Any device connected to some kind of hardware. For example, SCSI disk, 
fibre disk, network disk, RAM disk, etc.

Platformm
An underlying computer system on which application programs can run. A 
platform consists of an operating system, the computer system's 
coordinating program, and a microprocessor, the microchip in the computer 
that performs logic operations and manages data movement in the computer.

Plug and Play
The ability to install peripheral cards or other devices without requiring 
manual configuration by the user.

PROM
Programmable Read-Only Memory, memory that users with appropriate 
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instructions can reprogram.

Protocol
A special set of rules for transmitting data between two devices in a 
telecommunication connection.

Queue
A line of things, commands, or data waiting to be handled, usually in 
sequential order starting at the beginning or top of the line or sequence.

RAID
Redundant Array of Independent Disks, a collection of two or more disks 
working together in an array. Mylex RAID controllers implement this 
technology to connect up to 15 SCSI devices per channel. The different 
forms of RAID implementation are known as “RAID levels.” See also 
Berkeley RAID Levels, Disk Array, and RAID Levels.

The system manager or integrator selects the appropriate RAID level for a 
system. This decision will be based on which of the following are to be 
emphasized:

• Disk Capacity

• Data Availability (redundancy or fault tolerance)

• Disk Performance

RAID Advisory Board (RAB)
An association of companies whose primary intention is to standardize 
RAID storage systems. IBM is a member of RAB.
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RAID EzAssist™ 
A Mylex RAID management utility for configuration and maintenance of 
RAID controllers.

RAID Levels
Mylex disk array controllers support four RAID Advisory Board approved 
(RAID 0, RAID 1, RAID 3, and RAID 5), two special (RAID 0+1, and 
JBOD), and three spanned (RAID 10, 30, and 50) RAID levels. All 
DAC960, AcceleRAID, and eXtremeRAID series controllers support these 
RAID levels. See also Berkeley RAID Levels. 

Level 0: Provides block “striping” across multiple drives, yielding higher 
performance than is possible with individual drives. This level does not 
provide any redundancy.

Level 1: Drives are paired and mirrored. All data is 100 percent duplicated 
on a drive of equivalent size.

Level 3: Data is “striped” across several physical drives. Maintains parity 
information which can be used for data recovery.

Level 5: Data is “striped” across several physical drives. For data 
redundancy, drives are encoded with rotated XOR redundancy.

Level 0+1: Combines RAID 0 striping and RAID 1 mirroring. This level 
provides redundancy through mirroring.

JBOD: Sometimes referred to as “Just a Bunch of Drives.” Each drive is 
operated independently like a normal disk controller, or drives may be 
spanned and seen as a single drive. This level does not provide data 
redundancy.

Level 10: Combines RAID 0 striping and RAID 1 mirroring spanned across 
multiple drive groups (super drive group). This level provides redundancy 
through mirroring and better performance than Level 1 alone. 

Level 30: Data is “striped” across multiple drive groups (super drive group). 
Maintains parity information, which can be used for data recovery.

Level 50: Data is “striped” across multiple drive groups (super drive group). 
For data redundancy, drives are encoded with rotated XOR redundancy.
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Note: The host operating system drivers and software utilities remain 
unchanged regardless of the level of RAID installed. The controller makes 
the physical configuration and RAID level implementation. 

RAID Migration
A feature in RAID subsystems that allows for changing a RAID level to 
another level without powering down the system. 

RAM
Random Access Memory, the “built-in” readable and writable data storage 
that comes with (or can be added to) a computer.

Read-Ahead Cache
A caching strategy whereby the computer anticipates data and holds it in 
cache until requested. 

Recovery
The process of reconstructing data from a failed disk using data from other 
drives.

Redundancy
The inclusion of extra components of a given type in a system (beyond those 
the system requires to carry out its functions).

Replacement Table
A table that contains information regarding which SCSI devices have been 
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replaced by others through standby replacement. 

ROM 
Read-Only Memory, built-in computer memory containing data that 
normally can only be read, not written to. ROM contains the programming 
that allows a computer to be “booted up” each time you turn it on. Unlike a 
computer's random access memory (RAM), the data in ROM is not lost when 
the computer power is turned off; the ROM is sustained by a small long-life 
battery in your computer.

Rotated XOR Redundancy
XOR refers to the Boolean “Exclusive-OR” operator. Also known as Parity, a 
method of providing complete data redundancy while requiring only a 
fraction of the storage capacity of mirroring. In a system configured under 
RAID 3 or RAID 5 (which require at least three SCSI drives), all data and 
parity blocks are divided amongst the drives in such a way that if any single 
drive is removed (or fails), the data on it can be reconstructed using the data 
on the remaining drives. In any RAID 3 or RAID 5 array, the capacity 
allocated to redundancy is the equivalent of one drive. 

RTC
Real-Time Clock, a clock that keeps track of the time with its own power 
supply.

SAF-TE
SCSI Accessed Fault-Tolerant Enclosure, an “open” specification designed 
to provide a comprehensive standardized method to monitor and report 
status information on the condition of disk drives, power supplies, and 
cooling systems used in high availability LAN servers and storage 
subsystems. The specification is independent of hardware I/O cabling, 
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operating systems, server platforms, and RAID implementation because the 
enclosure itself is treated as simply another device on the SCSI bus. Many 
other leading server, storage, and RAID controller manufacturers worldwide 
have endorsed the SAF-TE specification. Products compliant with the SAF-
TE specification will reduce the cost of managing storage enclosures, 
making it easier for a LAN administrator to obtain base-level fault-tolerant 
alert notification and status information. All Mylex RAID controllers feature 
SAF-TE.

SAN
See Storage Area Network

SANArray™   
Server-independent External RAID Controllers that provide fibre channel 
interface connections to loop or fabric topologies and dual redundant loops 
for continuous access to large data pools. These controllers are designed for 
homogeneous and heterogeneous operating system setups in Storage Area 
Network environments.

SANmapping™  
A feature of SANArray external controllers, SANmapping manages drive 
allocation and access, and is similar to the programmable LUN Mapping 
feature, which is incorporated into this feature. SANmapping is intended for 
use in configurations in which multiple host computers attach to one or more 
Mylex controllers or to a Storage Area Network (SAN) configuration. 

SDRAM
Synchronous Dynamic Random Access Memory, a form of dynamic random 
access memory (DRAM, a type of memory used in computers) that can be 
coordinated or synchronized to the clock speed of the computer. 
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Sector
The unit in which data is physically stored and protected against errors on a 
fixed-block architecture disk.

Segment Size 
See Cache Line Size

Sequential I/O
A type of read and write operation where entire blocks of data are accessed 
one after another in sequence, as opposed to randomly.

Server
A computer program that provides and manages services to other computer 
programs on the same or other computers. The computer that a server 
program runs on is also frequently referred to as a server. See also 
Application Server.

Session
The period of time between any two consecutive system shutdowns; system 
shutdown may be either a power off/on, or a hardware reset.

SMART
Self-Monitoring Analysis and Reporting Technology, the industry standard 
reliability prediction indicator for both the ATA/IDE (advanced technology 
attachments/integrated drive electronics) and SCSI hard disk drives. Hard 
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disk drives with SMART offer early warning of some hard disk failures so 
critical data can be protected.

SMB
Server Message Block protocol, a method for client applications in a 
computer to read and write to files on, and to request services from server 
programs in, a computer network. A client application can read, create, and 
update files on the remote server. It can also communicate with any server 
program that is set up to receive an SMB client request.

SNMP
Simple Network Management Protocol, the protocol governing network 
management: for monitoring network devices and their functions.

Software Driver
Set of utilities and instructions for controllers to work in a specific operating 
system environment.

Spanning
A process that provides the ability to configure multiple drive packs or parts 
of multiple drive packs. In effect, spanning allows the volume used for data 
processing to be larger than a single drive. Spanning increases I/O speeds, 
however, the probability of drive failure increases as more drives are added 
to a drive pack. Spanned drive packs use striping for data processing. See 
also Striping and Drive Groups, Drive Packs.

Storage Area Network (SAN)
A high-speed, open-standard scalable network of storage devices and servers 
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providing accelerated data access.

Stripe Orderder
The order in which SCSI disk drives appear within a drive group. This order 
must be maintained, and is critical to the controller’s ability to “rebuild” 
failed drives.

Stripe Size
The size, in kilobytes (1024 bytes) of a single I/O operation. A stripe of data 
(data residing in actual physical disk sectors, which are logically ordered 
first to last) is divided over all disks in the drive group. 

Stripe Width
The number of striped SCSI drives within a drive group.

Striping
The storing of a sequential block of incoming data across multiple SCSI 
drives in a group. For example, if there are 3 SCSI drives in a group, the data 
will be separated into blocks. Block 1 of the data will be stored on SCSI 
drive 1, block 2 on SCSI drive 2, block 3 on SCSI drive 3, block 4 on SCSI 
drive 1, block 5 on SCSI drive 2, and so on. This storage method increases 
the disk system throughput by ensuring a balanced load among all drives.

Sustained Data Transfer Rate
A rate of data transfer defined for continuous operation at a maximum speed 
level.
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Synchronous Data Transfer
Data transmission synchronized to a defined time interval, and is faster than 
asynchronous SCSI because there is no wait for acknowledgment of each 
byte from the receiving device (up to 20MHz). Compare with Asynchronous 
Data Transfer.

System Disk
The disk on which a system’s operating software is stored.

System Drives 
See Logical Drives

TCP/IP 
Transmission Control Protocol/Internet Protocol, the basic communication 
language or protocol of the Internet. It can also be used as a communications 
protocol in intranets and extranets. When set up with direct access to the 
Internet, a computer is provided with a copy of the TCP/IP program just as 
every other computer that you may send messages to or get information from 
also has a copy of TCP/IP.

Terabyte 

A measure of memory capacity, 240 power; or roughly a thousand billion 
bytes (that is, a thousand gigabytes).

Throughput 
The number of I/O requests satisfied per unit of time (usually per second).
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TPC-C, Tpm-C
The Transaction Processing Performance Council (TPC) is a standards 
organization that measures transaction throughput of systems. One of their 
benchmarks is Tpm-C, which reflects price and performance metrics. TPC-C 
reflects new order transaction rate, a benchmark for transaction speed. 
Mylex products have won consistently high TPC-C results.

Transfer Rate 
The rate at which data moves between the host computer and storage, input, 
or output devices, usually expressed as a number of characters per second.

WAN 
Wide Area Network, a geographically broader telecommunication structure 
as opposed to a local area network (LAN) that comprises of two or more 
LANs. A wide area network may be composed entirely of private structures, 
but the term also seems to connote the inclusion of public networks and all 
kinds of transmission media.

Web 
A number of computers, servers, or networks linked together in a matrix. See 
also Internet and Intranet.

Write-Back Cache 
A caching strategy whereby write operations result in a completion signal 
being sent to the host operating system as soon as the cache (not the disk 
drive) receives the data to be written. The target disk drive will receive the 
data at a more appropriate time in order to increase controller performance. 
An optional cache battery backup can be used to protect against data loss as 
a result of a power failure or system crash. 
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Write-Through Cache 
A caching strategy whereby data is written to the SCSI drive before a 
completion status is returned to the host operating system. This caching 
strategy is considered more secure, since a power failure will be less likely to 
cause loss of data. However, a write through cache results in a slightly lower 
performance.

XOR 
Exclusive “Or”, a computer language function that generates parity in RAID 
systems; “this or that but not both.”
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